Content of this Instruction Manual
DPP is used for Digital Photo Professional.
In this manual, the screens used in the basic operation instructions are from Windows 7, with some portions using screens from other versions of Windows.
▶ indicates the selection procedure of the menu. Example: [File] menu ▶ [Exit].
Square brackets are used to indicate items such as menu names, button names and window names that appear on the computer screen.
Text inside < > indicates a key on the keyboard.
** indicates a reference page. Click to move to the relevant page.
? : Marks helpful information when a problem arises.
💡 : Marks tips for using the software skillfully.
⚠️ : Marks information that should be read before use.
نسخة : Marks additional information you may find helpful.

Switching Between Pages
Click on arrows on the bottom right of the screen.
▶ : next page
◀ : previous page
🏠 : return to a page you had previously displayed

Click on the chapter headings on the right side of the screen to switch to the contents page of that chapter. Also, click the item you want to read about on the table of contents to move to the relevant page.

Help and Shortcut Keys
For information about using DPP, refer to Help from the [Help] menu.
Refer to the [Troubleshooting] ▶ [Shortcut Key List] in the Help for a list of shortcut keys which are helpful for quick operation.
READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single computer. You may physically transfer the SOFTWARE from one computer to another provided that the SOFTWARE is used on only one computer at a time. You shall not install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware configuration where the SOFTWARE is accessible to more than one CPU or to more than one user.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or to copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for use of the SOFTWARE. No updates, fixes or support will be made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, maintain and match the hardware and software components of your computer system. Thus Canon does not guarantee uninterrupted service or correction of errors or that the functions or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material under normal use for a period of ninety (90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same without charge when returned by you at your expense to your point of purchase and proven to be defective upon inspection. The replacement CD-ROM will be warranted for the remainder of the original ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate without notice to you if you fail to comply with any of the terms of this Agreement and you must then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the United States of America shall be governed and construed in all respects in accordance with the laws and regulations of the State of New York, without reference to choice of law principles.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the SOFTWARE is subject to the United States, Canada and other applicable copyright and trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any images, graphics or textual material that you save in connection with the Software.

10. ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance RAW image processing, viewing and editing software for EOS DIGITAL cameras. It is often thought that RAW images are difficult to handle compared with ordinary JPEG images, but using DPP, you can perform advanced edits and print RAW images with ease.

RAW Images and Their Features

What is a RAW Image?

A RAW image is image data that has recorded output data of imaging sensor. Because image processing does not occur inside the camera when a photo is taken and the photo has been recorded in the special form of “RAW image data + Image processing conditions information at the time of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In the same way, for RAW images too, you cannot view them as images on your computer unless you perform subsequent image signal processing. Therefore, even though it is digital, this processing is called “development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose development processing has been completed. With DPP, you can view, edit and print RAW images without having to be particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image processing conditions information at the time of shooting”. When you open a RAW image in DPP, the image is automatically developed and you can view the image as an image to which image processing conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened (it undergoes automatic development processing each time), only the image processing conditions (development conditions) change and the “original image data itself” remains unaffected. Consequently, image deterioration is not a problem and it is the perfect image data for users who want to get creative with their images after they have been shot.

In DPP, the “Image processing conditions information” that can be adjusted is called a “Recipe”.

RAW image data

Image processing conditions information
Main Features of DPP

Following are the main tasks you can perform with images you have downloaded to your computer.

- View and organize RAW images
- Real-time adjustment of a RAW image
  - Various image adjustments while maintaining the original image
  - Freely apply a Picture Style
  - View your image before and after adjustment in the same window
- Trimming and adjusting the angle of an image
- Change image size
- Correction of lens aberration
- Automatic/manual dust erasure processing
- Convert from a RAW image to a JPEG or TIFF image and save
  - Process large numbers of RAW images in batches
  - Transfer the image to image editing software
- Print a RAW image
- View and organize JPEG and TIFF images
- Real-time adjustment of JPEG and TIFF images
  - Various image adjustments while maintaining the original image
- Print JPEG and TIFF images
- Color management compatibility
  - CMYK simulation for commercial printing

System Requirements

<table>
<thead>
<tr>
<th>OS</th>
<th>Windows 7<em>1, Windows Vista</em>2, Windows XP Professional/Home Edition*3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>PC with one of the above OS preinstalled</td>
</tr>
<tr>
<td>CPU</td>
<td>1.3GHz Pentium or higher*4</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum 1GB*5</td>
</tr>
<tr>
<td>Display</td>
<td>Screen resolution: 1024 × 768 pixels or more</td>
</tr>
<tr>
<td></td>
<td>Color quality : Medium (16 bit) or more</td>
</tr>
</tbody>
</table>

*1 Compatible with 32-bit/64-bit systems for all versions except Starter Edition
*2 Compatible with 32-bit/64-bit systems for Service Pack 1 and Service Pack 2 except Starter Edition
*3 Compatible with Service Pack 3
*4 Core2 Duo or higher is recommended
*5 For Windows 7 64-bit systems, minimum 2GB

Check the Canon website for the latest system requirements, including supported OS versions.

Supported Images

This software supports the following image types.

<table>
<thead>
<tr>
<th>Image type</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW images*1 shot with EOS DIGITAL cameras, excluding EOS DCS1 and EOS DCS3</td>
<td>.CR2, .TIF, .CRW</td>
</tr>
<tr>
<td>RAW images*2 shot with PowerShot cameras</td>
<td></td>
</tr>
<tr>
<td>JPEG images</td>
<td>.JPG, .JPEG</td>
</tr>
<tr>
<td>TIFF images</td>
<td>.TIF, .TIFF</td>
</tr>
</tbody>
</table>

*1 Compatible with RAW images shot with EOS D6000 or EOS D2000 that have been converted to RAW images using the CR2 Converter and have the “.CR2” extension. For information on CR2 Converter, refer to Canon’s web site.

*2 Only models where Digital Photo Professional is listed in the “Data Type” item in the “Specifications” section near the end of the Camera User Guide.
- Use the dedicated CameraWindow application to download images from a PowerShot camera to a computer. See the Software Starter Guide for details.
- Lens aberration correction can only be used with some camera and lens models.
- Automatic dust erasure processing and other EOS DIGITAL specific functions cannot be used.
- RAW images shot with the PowerShot Pro1 are also supported, but they cannot be edited with the DPP RAW image adjustment function.
## Contents at a Glance

### Downloading Images to Your Computer
- Download images by connecting your camera and computer → p.7
- Download images using a card reader → p.9

### Viewing and Checking RAW Images
- Quickly enlarge parts of an image → p.11
- Sort images (check marks, rating) → p.18, p.19
- Display an image shot simultaneously as a RAW image and JPEG image as a single image → p.22
- Display the images in the thumbnail list display at high resolution → p.23
- Check shooting information such as the shooting date → p.10, p.23

### Editing RAW Images (Adjusting)
- Adjust brightness/darkness → p.12, p.26
- Use automatic adjustment → p.33
- Change the Picture Style → p.26
- Sharpen the modulation and contrast of colors (contrast) → p.29
- Make skin tone look healthier (color tone) → p.29
- Make the image colors more vivid (color saturation) → p.29
- Make an image sharp (sharpness) → p.31
- Adjust an image to make color tone more natural (white balance) → p.27
- Change an image to black-and-white or sepia tones (monochrome) → p.30
- Trim an image and adjust the angle of an image → p.38
- Specify an aspect ratio that matches the size of the paper on which an image is to be printed → p.38
- Erase dust shot with the image → p.73, p.75
- Erase unwanted parts of an image → p.77
- Auto correct RAW images with the Auto Lighting Optimizer → p.61
- Adjust brightness of shadows/highlights → p.57
- Reduce image noise → p.62
- Correct lens aberration → p.63
- Use the Digital Lens Optimizer → p.69
- Use a Picture Style file → p.59
- Edit efficiently → p.34
- Edit an image while comparing the image before and after adjustment → p.53
- Synchronize multiple images → p.54
- Display an area beyond the set range as a warning indicator (Highlight/Shadow warning) → p.55
- Restore an adjusted image to its condition at the time of shooting → p.43
- Composite images → p.78
- Create HDR (High Dynamic Range) images → p.81

### Printing
- Print well on a Canon printer → p.43, p.87, p.88
- Faithfully reproduce the color of the subject when printing → p.43, p.87, p.88
- Print with the shooting information → p.85
- Print a thumbnail list of images → p.86
- Approximate the color seen on screen with your printing results → p.93

### Conversion of Images
- Convert a RAW image to a JPEG image → p.42, p.99
- Edit in Photoshop → p.77, p.100
- Perform batch processing → p.99
- Edit (adjust) a JPEG image → p.103
1 Basic Operation

The basic operational flow – from how to download to your computer images shot with a camera to checking, editing, saving and printing a downloaded RAW image – is explained here.

Starting up DPP ......................................................... 6
  Main Window Display .............................................. 6

Downloading an Image to Your Computer .............. 7
  Downloading Images Using Your Card Reader........... 9

Viewing an Image .................................................... 10
  View Images as Thumbnails in the Main Window ...... 10
    Changing the Size of Thumbnail Images ................ 10
  Enlarge and View an Image in the Edit Window ...... 11
  Enlarging and Viewing a Specific Area .................. 11

Adjusting an Image ................................................... 12
  About the Tool Palette ......................................... 12
  About Recipes ..................................................... 12

Saving an Image .................................................... 13
  Saving ............................................................... 13

Printing an Image ................................................... 14
  Printing ............................................................. 14

Exiting DPP .......................................................... 14
Starting up DPP

Double-click the desktop icon.

DPP starts up and the main window ([Folder] window) appears.

Main window ([Folder] window)

**Main Window Display**

In the main window, you can use tabs to select either the [Folder] window or the [Collection] window. The [Folder] window displays the images in folders on your computer, while the [Collection] window (p.36) displays images selected randomly by the user from one or more folders and gathered together. Unless noted otherwise, the [Folder] window will be described as the main window from this point on.

[Folder] window

[Collection] window
Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and download the images saved on the memory card inserted in the camera. For downloading images, start up the camera software “EOS Utility” from DPP and use.

1. Select the save destination for the images.
   - Select the save destination in the folder area on the left of the main window.
   - When creating a folder, see p.50.

2. Start up EOS Utility.
   - Select the [Tools] menu ➜ [Start EOS Utility].

3. Connect your camera and computer and turn the camera on.
   - Connect the camera and your computer with the interface cable provided with the camera and turn the camera on.
   - For detailed instructions on connecting your camera and computer, refer to the “EOS Utility Instruction Manual” (PDF electronic manual).

   ➜ The capture window for EOS Utility appears.

EOS Utility

Downloaded images are displayed in the folder area on the left of the main window.

1. Select the save destination for the images.
   - Select the save destination in the folder area on the left of the main window.
   - When creating a folder, see p.50.

2. Start up EOS Utility.
   - Select the [Tools] menu ➜ [Start EOS Utility].

   EOS Utility starts up.

3. Connect your camera and computer and turn the camera on.
   - Connect the camera and your computer with the interface cable provided with the camera and turn the camera on.
   - For detailed instructions on connecting your camera and computer, refer to the “EOS Utility Instruction Manual” (PDF electronic manual).

   The capture window for EOS Utility appears.

Downloaded images are displayed in the folder area on the left of the main window.
Click the [Main Window] button.

The main window for EOS Utility appears.

Download images.

Downloading of images begins.

The downloaded images are saved in the folder selected in step 1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and saved.

Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your images as they are downloaded, sorted and saved into folders by date.

- You cannot start up EOS Utility in the [Collection] window (p.6, p.36).
- When EOS Utility has been started up from DPP, you cannot use the following functions.
  - Quick check window view (p.16)
  - Trimming and adjusting the angle of an image (p.38, p.111)
  - Digital Lens Optimizer (p.69)
  - Compositing images (p.78)
  - Creating HDR (High Dynamic Range) images (p.81)
  - Dust erasure processing (copy stamp function) (p.73 to p.77, p.114 to p.118)
  - Batch change file names (rename function) (p.101)
  - Printing with shooting information (p.85)
  - Printing a thumbnail list (contact sheet printing) (p.86)
  - Printing using Easy-PhotoPrint EX or Easy-PhotoPrint (Plug-in printing) (p.43, p.46)
  - Transferring images to Photoshop (p.77)
  - Batch saving images (batch processing) (p.99)
Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card reader.

1. Load the memory card into the card reader.

2. Open [My Computer] → [EOS_DIGITAL] and drag the [DCIM] folder to the [Desktop].

3. Display the images downloaded to your computer.
   - In the [DCIM] folder copied to your desktop, select the folder where the shot images are saved.

> Images in the folder are displayed in the main window of DPP.

The [DCIM] folder is downloaded to your computer.
- All images are saved in folder units inside the [DCIM] folder.

Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the folder are displayed in DPP and you can check the shot images.

- Copying to your computer may take time when there is a large number of shot images saved in the memory card.
Images downloaded to your computer are displayed as a thumbnails list in the main window. You can double-click an image to open the edit window and display the image at large size.

View Images as Thumbnails in the Main Window

Click to select the image
Display thumbnails of all the images inside the folder selected in the folder area on the left

- Images displayed with the [ ] icon are movie files and cannot be played back in DPP. Please use “ImageBrowser EX”, which is compatible with EOS DIGITAL movie files.
- If the message [Insufficient memory.] appears, there are too many images in one folder. Decrease the number of images in one folder such as by dividing them into smaller folders.
- When aspect ratio information is attached to the shot image with the EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS REBEL T3i/600D, the image is displayed as a trimmed image (p.38, p.111).
- For a list of main window functions, see p.124.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main window and display them with shooting information attached.

Select the [View] menu ➔ desired item.
Enlarge and View an Image in the Edit Window

The edit window appears.

Double-click

The area you double-clicked is enlarged to 100% (actual pixel size). If you wait for a while, it changes to a clearer display.

Double-click again to revert to the full view.

To change the display position, drag on the image or drag the enlargement display position of the tool palette.

Enlarging and Viewing a Specific Area

Double-click the area you want to enlarge.

Edit window

Tool palette

Enlarging and Viewing a Specific Area

Double-click the area you want to enlarge.

The edit window appears.

Double-click

It may take time for the image to redraw itself.

Click the [ ] in the upper right of the edit window to close the edit window.

By selecting the [View] menu [AF Point] in the edit window, you can display the AF points selected in the camera at the time of shooting. However, AF points are not displayed for images whose image size has been changed and then been converted and saved (p.42, p.134), images for which you selected an effect other than [Shot settings] as correction of fisheye lens distortion aberration, or images which have had settings specified during RAW processing on the camera for distortion correction and chromatic aberration correction.

For a list of edit window functions, see p.127.

To display an image in an enlargement ratio other than 100%

Select the [View] menu [200% view] or [50% view].

You can change the enlargement ratio when you double-click (p.91).
Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the brightness or changing the Picture Style of an image using the tool palette of the edit window. You can easily restore an image to its original settings with the [ ] button even if you have made the wrong adjustment. Try out the various adjustments. As an example, the procedure to adjust the brightness of an image is explained here.

About the Tool Palette

You can adjust images with the tool palette by switching between the [RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your editing requirements. Because adjustment made with the tool palette (it undergoes automatic development processing each time) only changes the image processing conditions, the “original image data itself” remains unaffected. Therefore, there are no problems with image deterioration that arise with editing and you can readjust your images any number of times. See Chapter 2 onwards for more detailed information on the various functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions information) made with the tool palette is saved to an image as data called a “Recipe” (p.96).

The tool palette does not display

Select the [View] menu → [Tool palette].

For a list of tool palette functions, see p.128.
Saving an Image

If you perform the save operation described here, you can save all the adjustment contents (recipe) made with the tool palette to the RAW image.

**Select the [File] menu ➤ [Save].**

- Your adjustment contents (recipe) are saved to the image.

**Saving**

With DPP, you can perform the following types of saving according to your requirements. For detailed information on each saving method, see Chapter 2 onwards.

- **Save** *(p.41)*
  - Add adjustment contents (recipe) made with the tool palette to a RAW image and save.

- **Save as** *(p.41)*
  - Add adjustment contents (recipe) made with the tool palette to a RAW image and save as a separate RAW image. The original RAW image remains unaffected.

- **Add thumbnail to image and save* (p.23)**
  - Create a new thumbnail image for the main window and save to each image. The quality of images in the main window improves and images redraw themselves more quickly.

- **Convert and save** *(p.42)*
  - Convert adjusted RAW image to a JPEG or TIFF image and save. The original RAW image remains unaffected.

- **Batch process** *(p.99)*
  - Convert in batches adjusted multiple RAW images to JPEG or TIFF images and save. The original RAW images remain unaffected.

* Option available in the main window.
Printing an Image

You can print images with a printer. As an example, the procedure to print one image on one sheet of paper is described here.

1. Select the [File] menu ➤ [Print].

   → The printer’s print settings dialog box appears.

2. Print.
   - Specify the optimum settings for photograph printing in the printer’s print settings dialog box and click the [OK] button.
   - Printing begins.

   → DPP exits.

Printing

With DPP, you can perform the following types of printing according to your requirements. For detailed information on each printing method, see Chapter 2 onwards.

- Print one image (p.49)
- Print using a Canon inkjet printer (p.43, p.46)
- Print with a high-end Canon printer (p.87)
- Print with shooting information (p.85)
- Printing a thumbnail list (contact sheet printing) (p.86)

Exiting DPP

In the main window, select the [File] menu ➤ [Exit].

A confirmation dialog box for saving the images appears when you try to exit DPP without saving the adjusted image. Click the [Yes to all] button to save the adjustment contents (recipe) to all the images adjusted.
Advanced Operation

A more advanced operation – from efficiently checking images, to various ways of editing an image, printing a RAW image using a Canon printer and sorting images – is explained here.

Efficiently Checking/Sorting Images.................................................. 16
  Sorting Images................................................................................. 18
    Attaching Check Marks.............................................................. 18
    Setting Ratings.............................................................................. 18
  Sorting Images in the Main Window............................................. 19
    Attaching Check Marks in the Main Window............................... 19
    Setting Ratings in the Main Window.......................................... 19
  Arranging Images in the Main Window.......................................... 20
    Arranging by Type......................................................................... 20
    Arranging Freely........................................................................... 21
  Displaying a RAW Image and JPEG Image as a Single Image.......... 22
  Improving the Quality of an Image in the Main Window.................. 23
  Checking Image Information.......................................................... 23

Editing an Image............................................................................ 25
  About the RAW Tool Palette.......................................................... 25
    Editing with the Tool Palette in the Main Window....................... 25
  Adjusting Brightness....................................................................... 26
  Changing a Picture Style.................................................................. 26
    Picture Style File........................................................................... 27
  Adjusting Color Tone by Changing White Balance......................... 27
  Adjusting Color Tone Using Click White Balance........................... 28
  Adjusting Contrast.......................................................................... 29
  Changing Color Tone and Color Saturation.................................... 29
    Adjusting Monochrome.................................................................. 30
  Adjusting Image Sharpness.............................................................. 31

Detailed Setting of Image Sharpness................................................. 32
  Automatically Adjusting Brightness and Color (Tone Curve Assist)........................................................................ 33

Editing Efficiently............................................................................ 34
  Editing in the Edit Image Window................................................... 34
  Changing the Thumbnail Display Position to a Horizontal Position................................................................. 36
  Gathering and Editing Images in the Collection Window................. 36

Trimming and Adjusting the Angle of an Image................................ 38

Applying Adjustment Contents to Other Images.............................. 41

Saving Editing Results...................................................................... 41
  Saving Editing Contents to a RAW Image........................................ 41
  Saving as a JPEG or TIFF Image...................................................... 42

Re-Editing an Image.......................................................................... 43

Printing an Image............................................................................. 43
  Printing Photographs with Canon Inkjet Printers Compatible with Easy-PhotoPrint EX.................................................. 43
  Printing Photographs with Canon Inkjet Printers Compatible with Easy-PhotoPrint.................................................... 46
  Printing Photographs with a Printer other than Canon Inkjet Printers................................................................. 49

Organizing Images............................................................................ 49
  Deleting an Unwanted Image.......................................................... 49
  Creating a Folder for Saving Images............................................... 50
  Moving Images................................................................................. 50
  Moving Images in Folders............................................................... 51
  Registering Frequent-Use Folders (Bookmark Registration).............. 51
    Organizing Bookmarks................................................................... 51
Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window and efficiently check each image. You can attach check marks and sort images into five groups.

1. **Display the quick check window.**
   - Click the [Quick check] button.

   ![Quick check window]

   → The quick check window appears.

2. **Click the [Next] or [Previous] button to switch between images to be checked.**

   Quick check window

   ![Quick check window]

   → All the images displayed in the main window can be checked in the quick check window.

3. **Double-click the area you want to enlarge.**

   ![Double-click example]

   → The area you double-clicked is enlarged to 50% view.
   - To change the display position, drag on the image.
   - Double-click again to revert to the full view.
   - To exit, click the [OK] button.

   ![](COPY)

   When [AF Point] is checkmarked, you can display the AF points selected in the camera at the time of shooting. However, AF points are not displayed for images which have had their image size changed and then been converted and saved (p.42, p.134), which have had settings specified during RAW processing on the camera for distortion correction and chromatic aberration correction, which are composited, or which are created as HDR (High Dynamic Range) images.
Convenient functions of the quick check window

- **To check only selected images**
  You can use the quick check window to check only selected images by selecting the desired images from those displayed in the main window and then performing step 1.

- **Switch between images using the keyboard**
  You can also switch between images by pressing the← or → key.

- **Switch between screens using the keyboard**
  You can also switch between full screen display/normal screen display by pressing the Alt + Enter keys.

- **Operate using the menu**
  Each operation can also be performed with the menu which appears when you right-click with the mouse on an image.

- The enlargement ratio when an image is enlarged is half (50%) of the 100% (actual pixel size).
- You can change the enlargement ratio to 100%, when an image is enlarged (p.91).
- For a list of quick check window functions, see p.132.
**Sorting Images**
You can sort images by attaching check marks or setting ratings (indicated with [★] marks) for each subject or theme.

**Attaching Check Marks**
Display the image you want to attach a check mark to, and then click any one of [1] to [5].

The selected check mark appears in the upper left of the window.

- Click the [Clear] button to remove the check mark.

**Setting Ratings**
Display the image you want to rate, and then click any one of the [★].

- The rating is set and an icon corresponding to the selected [★] appears in the upper left of the window. (Window shown with a rating of three [★])
- To set [Reject], click the [Reject] button. Click the [Reject] button again to cancel.
- To cancel the rating, click the same [★] as when the setting was made on the right of the window.

As the file structure of the image data is changed when a rating is set to an image, it may not be possible to check the image information in third-party software.

You can also set ratings (including [Reject] setting) from the menu that appears by right-clicking with the mouse on an image in the main window.
Sorting Images in the Main Window
You can also sort images in the main window by attaching check marks or setting ratings (indicated with [ ] marks) for each subject or theme.

Attaching Check Marks in the Main Window
Select the images you want to attach a check mark to, and then click any of [ ] to [ ] in the toolbar.

- The selected check mark appears in the upper left of the image frame.

Setting Ratings in the Main Window
Select the images you want to rate, and then click any of the [ ] in the toolbar.

- The rating is set and an icon corresponding to the selected [ ] appears in the image frame. (Window shown with a rating of three [ ] as an example)

- To cancel the rating, click the same [ ] as when the setting was made in the toolbar.
- [Reject] cannot be set with the toolbar. Set [Reject] with the [Label] menu or the quick check window (p.18).
To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select multiple consecutive images, click on the first image, and then click on the last image while holding down the <Shift> key.

To display more thumbnails in the main window

You can display a large number of images by setting the size of thumbnail images to small (p.10). Then, by selecting the [View] menu  [Rating] and removing check marks so that ratings no longer appear in the image frame, you can display still more thumbnail images in the main window.

- The [Label] menu can also be used to attach check marks and set ratings.
- By selecting the [Edit] menu  [Check mark] or [Rating] image selection criteria, you can refine criteria for selecting checkmarked or rated images.
- You can display and change the rating settings set in DPP with other bundled software and on an EOS-1D X, EOS 5D Mark III, EOS 7D (firmware version 2.0.0 or later), EOS 60D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, or EOS REBEL T3/1100D camera.
  - EOS Utility version 2.9 or later:
    - Ratings set in DPP are displayed. However, [Reject] is not displayed and you cannot change rating settings.
  - On an EOS-1D X, EOS 5D Mark III, EOS 7D (firmware version 2.0.0 or later), EOS 60D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, or EOS REBEL T3/1100D camera:
    - Ratings set in DPP are displayed in the playback screen. You can also change rating settings. However, you cannot display or change settings for [Reject].
- Reversely, you can also display and change with DPP the rating settings set for still images on an EOS-1D X, EOS 5D Mark III, EOS 7D (firmware version 2.0.0 or later), EOS 60D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, or EOS REBEL T3/1100D camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you have attached to images, or in the order of date and time at which the images were shot. You can also freely arrange images by moving them individually.

Arranging by Type

Select the [View] menu  [Sort]  desired item.

The images are arranged in the order according to the selected item.
<table>
<thead>
<tr>
<th>Sort item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating: ascending order</td>
<td>Sorted in order of fewest [★].</td>
</tr>
<tr>
<td>Rating: descending order</td>
<td>Sorted in order of most [★].</td>
</tr>
<tr>
<td>File name</td>
<td>Images are sorted by file name in alphanumeric order (0 to 9 → A to Z).</td>
</tr>
<tr>
<td>Shooting Date/Time</td>
<td>Images are sorted by shooting date and time from the earliest.</td>
</tr>
<tr>
<td>RAW priority</td>
<td>Images are sorted in the following order: RAW images → JPEG images → TIFF images.</td>
</tr>
<tr>
<td>Check mark1 - Check mark5</td>
<td>Images with check marks take priority and are sorted in number order.</td>
</tr>
</tbody>
</table>

**Arranging Freely**

Drag and drop the image to the desired location.

- The image moves to the desired location.
- You can also select multiple images (p.20) and move them.
- The order of rearranged images is maintained until you exit DPP or select another folder in the folder area.
- Select the [View] menu ➔ [Sort] ➔ [File name] to revert to the order before the images were rearranged.

**Check mark sorting order**

When check marks from 1 to 5 have been set, the images are sorted as follows:
- Check mark1 selected: 1→2→3→4→5
- Check mark2 selected: 2→3→4→5→1
- Check mark3 selected: 3→4→5→1→2
- Check mark4 selected: 4→5→1→2→3
- Check mark5 selected: 5→1→2→3→4

**Maintaining the order of rearranged images**

You can maintain the order of rearranged images even if you exit DPP or select another folder in the folder area.
- **Maintain order without changing image file names**
  You can use the [View settings] tab sheet in the [Preferences] to maintain the order of images without changing the image file names (p.91).
- **Maintain order and change image file names**
  You can use the rename function to maintain the order of images and change the image file names all at once in the order they were rearranged (p.101).
Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot simultaneously as a single image. In particular, you can halve the number of images displayed in the main window and you can streamline the checking of a large number of images shot simultaneously.

1. Select the [Tools] menu ➔ [Preferences].

2. Select the [View settings] tab sheet and checkmark [Display only CR2 images for CR2 and JPEG files of the same name].

The main window display updates and the simultaneously shot RAW image and JPEG image are displayed as a single image with the [R+J] mark (p.126).

RAW images with the extension “.CR2” can be displayed as a single image

Images that can be displayed as a single image are images shot with a camera that shoots RAW images with the extension “.CR2” and JPEG images simultaneously. Images that have been simultaneously shot with a camera that shoots RAW images with the extension “.CRW” or “.TIF” cannot be displayed as a single image.

💡 When a single image is displayed

- **Image displayed**
  The RAW image is displayed in all windows.

- **Edited image**
  The content which has been adjusted with any of DPP’s functions (the tool palette etc.) will be applied to the RAW image only. However, if you have used the following functions, the adjustments will be applied to both the RAW image and the JPEG image.
  - Deleting an image (p.49)
  - Moving or copying an image (p.50)
  - Checkmarks (p.18, p.19)
  - Rating (p.18, p.19)
  - Rotating an image (p.124, p.132, p.133)
  - Attaching a thumbnail to an image and saving (p.23)

- **Images added to the [Collection] window**
  When you add a RAW image and JPEG image displayed as a single image to the [Collection] window, the single image is marked with the [R+J] mark. However, because the RAW and JPEG images are actually added individually, the number of images shown on the [Collection] tab sheet increases by 2 (p.125).

💡 In step 2, if you uncheck [Display only CR2 images for CR2 and JPEG files of the same name], the RAW image and JPEG image are displayed as separate images.
Improving the Quality of an Image in the Main Window

Create a new thumbnail image for the main window and save to each image. The quality of images in the main window improves and images redraw themselves more quickly.

With all the images selected, select the [File] menu ➤ [Add thumbnail to image and save].

Checking Image Information

1. Select the image for which you want to check the image information.
2. Click the [Info] button.

The image information window appears (p.24).

The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image quality improves regardless of the thumbnail size (p.10), selecting [Large thumbnail], with its larger display size, shows the improvement more clearly than [Medium thumbnail] and [Small thumbnail].

A large number of images may take some time to add.
Select a tab sheet and check information.

[Shooting Information] tab sheet

- Shooting information is displayed in the [Shooting Information] tab sheet, while IPTC* information appended to the image after shooting is displayed in the [Metadata] tab sheet.
- IPTC* information provides additional comments on images, such as captions, credits and the shooting location. The information is sorted into 5 different categories and can be viewed by selecting [Description], [IPTC Contact], [IPTC Image], [IPTC Content] or [IPTC Status] from the list box in the [Metadata] tab sheet.
- IPTC information can only be appended to JPEG/TIFF images using Photoshop (CS3 or later).
* International Press Telecommunications Council (IPTC)

[Metadata] tab sheet

- The contents of the [Shooting Information] tab sheet will vary depending on the camera model.

Convenient uses in the main window

- **Switching displays**
  - If a different image is selected in the main window when the image information window is displayed, the image information for that image will be displayed.

- **Difference with the [Thumbnail with information]**
  - Detailed shooting information for each image is displayed in the image information window. However, if you want to only check the main shooting information, you can check it for each image in [View] menu [Thumbnail with information] (p.10).
Editing an Image

This section explains how to adjust an image using the tool palette in the edit window.

You can easily restore an image to its original condition with the [ ] button even if you have made the wrong adjustment. Try out the various adjustments.

How to make adjustments using the [RAW] tool palette functions, and how to adjust automatically with the [RGB] tool palette are explained in this section.

→ The image changes in real time according to adjustments performed with the tool palette.

To revert to the condition before the last operation performed on the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> + <Z> keys.

You can rotate an image in the [Adjustment] menu.

You can adjust an image while comparing the image before and after adjustment (p.53).

You can synchronize multiple images and edit while comparing them (p.54).

See p.127 for a list of edit window functions, and p.128 for a list of tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the [RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your editing requirements.

Adjustments similar to those that can be performed with the functions of your camera can be performed using the functions of the [RAW] tool palette. When the camera settings were incorrect during shooting, or when the shooting result is not what you visualized, you can get closer to what you envisaged with the [RAW] tool palette which is similar to the camera.

All functions other than [RGB] tool palette automatic adjustment, and each function of the [NR/ALO] and [LENS] tool palette are explained in Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool Palette] button (p.124) in the toolbar on the main window, the same tool palette that appears in the edit window is displayed and you can edit images.
**Adjusting Brightness**

The brightness of an image can be adjusted. Move the slider to the right to make the image brighter and to the left to make the image darker.

- Drag the slider left or right
- Enter a numerical value
- Reverts the image to the original settings

- The adjustment range is –2.0 to +2.0 (in 0.01-stop increments when entering a value).

---

**Changing a Picture Style**

If the image you shot is different to what you visualized, you can change the Picture Style to get closer to what you envisaged. Even if you have saved the image (p.41) with [Monochrome] (p.30) selected, you can still change to another Picture Style at any point by simply selecting a Picture Style other than [Monochrome].

- Reverts the image to the original settings
- Select

---

- Even if the RAW image is from a camera that does not have Picture Style settings, you can still set a Picture Style as long as the RAW image is compatible with DPP (p.3).
- You can retain the [Color tone], [Color saturation], [Contrast], [Unsharp mask] and [Sharpness] settings, even if you change the Picture Style (p.92).
- [Auto] is only applied to images shot with the EOS-1D X, EOS 5D Mark III, EOS REBEL T4i/650D or EOS REBEL T3i/600D. When changing a Picture Style with several images selected, you can select [Auto] if images shot with the EOS-1D X, EOS 5D Mark III, EOS REBEL T4i/650D or EOS REBEL T3i/600D are included. However, [Auto] is actually applied only to images shot with the EOS-1D X, EOS 5D Mark III, EOS REBEL T4i/650D or EOS REBEL T3i/600D.
- You cannot select [Auto] with multiple-exposure RAW images created on the camera.
## Picture Style File

A Picture Style file is an extended function file of Picture Style. See p.59 for how to use Picture Style files.

<table>
<thead>
<tr>
<th>Picture Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>The image looks vivid. Ordinarily, this setting is suitable for most images.</td>
</tr>
<tr>
<td>Auto</td>
<td>The color tone will be adjusted to suit the scene. The colors will look vivid, especially for blue skies, greenery, and sunsets in nature, outdoor, and sunset scenes.</td>
</tr>
<tr>
<td>Portrait</td>
<td>For nice skin tones. Effective for close-ups of women and children. By changing the [Color tone], you can adjust the skin tone (p.29).</td>
</tr>
<tr>
<td>Landscape</td>
<td>For vivid blues and greens. Effective for making images of landscapes impressive.</td>
</tr>
<tr>
<td>Neutral</td>
<td>For natural colors and subdued images. Effective for base images which are to undergo adjustment.</td>
</tr>
<tr>
<td>Faithful</td>
<td>When the subject is photographed under a color temperature of 5200K, the color is adjusted colorimetrically to match the subject’s color. Effective for base images which are to undergo adjustment.</td>
</tr>
<tr>
<td>Monochrome</td>
<td>For black and white images. You can also adjust with [Filter effect] or [Toning effect] (p.30).</td>
</tr>
<tr>
<td>(Picture Style file registered in the camera)</td>
<td>Displayed when selecting an image shot with the Picture Style file registered in the camera. In the list, the name of the Picture Style file is displayed in ( ).</td>
</tr>
<tr>
<td>[Picture Style file applied in DPP]</td>
<td>The name of the Picture Style file applied in DPP is displayed in [ ].</td>
</tr>
</tbody>
</table>

### Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural, change the white balance to make it appear natural. You can make the color tone natural by setting the light source at the time of shooting an image of, for example, pale-colored flowers.

![Reverts the image to the original settings](image)

#### Tune with color tone

To make further fine adjustments to color tone after adjusting the white balance, you can use [Color tone] (p.29) to get closer to your requirements.

- You cannot register the adjustment results as personal white balance (p.98) when you have selected [Shot settings] from the list box.
- You cannot change or adjust white balance with multiple-exposure RAW images created on the camera.

Refer to your camera’s Instruction Manual for details on each white balance setting.
Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the standard for white to make the image appear natural. Using click white balance is effective when using it in parts of an image where white color tone has changed under the influence of a light source.

1. Click on a point that is to be the standard for white.

   ![Click on a point that is to be the standard for white.]

   The coordinates of the cursor position and the RGB values (8-bit conversion)

   Reverts the image to the original settings

   The color of the image is adjusted with the point you selected as the standard for white.

   If you click on another point in the image, the white balance is adjusted again.

   To finish click white balance, right-click with the mouse or click the [ ] button again.

   When there are no white areas in your image

   When there are no white areas in your image, you can adjust the white balance by clicking on a grey point of the image in step 2. This has the same adjustment result as selecting a white point.

   The image is adjusted based on the average value of 5 × 5 pixel range from the clicked point.

   You cannot change or adjust white balance with multiple-exposure RAW images created on the camera.
**Adjusting Contrast**

Modulation and degree of contrast can be adjusted. Move the slider to the right to make contrast stronger and to the left to make contrast weaker.

[Image of Contrast Adjustment]

- **Reverts the image to the original settings**
- **Drag the slider left or right (9 steps)**
- **Displays the value of the setting**

**Linear - A function for advanced adjustment**

Use [Linear] when you will be adjusting separately using image editing software that has advanced editing functions. Note that when [Linear] is checkmarked, the image will become dim.

- The Auto Lighting Optimizer (p.61) will not function when [Linear] is checkmarked.

**Changing Color Tone and Color Saturation**

Skin tone and overall color saturation can be adjusted. If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color saturation] switch to [Filter effect] and [Toning effect] (p.30).

[Image of Color Tone and Saturation Adjustment]

- **Reverts the image to the original settings**
- **Drag the sliders left or right**
- **Displays the values of the setting**

**Color tone:** Mainly used for adjusting skin tones. Move the slider to the right to make skin tones more yellow, and to the left to make skin tones redder.

**Color saturation:** The overall color depth of the image is adjusted with color saturation. Move the slider to the right to make the color deeper, and to the left to make the color weaker.

- The adjustment range is –4 to +4 (in 1-stop increments).
Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create monochrome photographs with effects similar to filtering and with the look of a single-color photograph.


2. Drag the sliders left or right to adjust the filter effect.

Filter effect: Creates an image where the white of clouds and the green of trees are emphasized in the same monochrome photograph.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Example of effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Ordinary monochrome image without filter effect.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Blue sky is reproduced more naturally and white clouds emerge clearly.</td>
</tr>
<tr>
<td>Orange</td>
<td>Blue sky becomes somewhat darker. The brightness of the setting sun increases further.</td>
</tr>
<tr>
<td>Red</td>
<td>Blue sky becomes quite dark. Autumn leaves become clear and bright.</td>
</tr>
<tr>
<td>Green</td>
<td>Human skin tones and lips become softer. The green leaves of trees become clear and bright.</td>
</tr>
</tbody>
</table>

Toning effect: You can create a monochrome photograph to which a single color has been added. You can choose from [None], [Sepia], [Blue], [Purple] and [Green].

Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.
**Adjusting Image Sharpness**

You can make the overall atmosphere of an image harder or softer. Adjustment can be made by selecting from two modes, [Sharpness] and [Unsharp mask].

- **[Sharpness]**: Controls the sharpness of an image by adjusting the level of emphasis for the outline of the image. The further to the right the [Sharpness] slider is moved (the larger the setting), the more the edges are emphasized for a sharper image.

- **[Unsharp mask]**: Adjusts the image’s sharpness more finely.
  - **[Strength]**: Shows the level of emphasis for the outline of the image. The further to the right the slider is moved (the larger the setting), the more the image’s edges are emphasized for a sharper image.
  - **[Fineness]**: Shows the fineness of the emphasized outline. The further to the left the slider is moved (the smaller the setting), the more fine detail can be emphasized.
  - **[Threshold]**: Sets “how much contrast difference there should be compared to surroundings before emphasizing edges”.

---

**Select [Sharpness] from the list box and make the setting.**

- **Reverts the image to the original settings**
  - Drag the slider left or right
  - Displays the value of the setting

The adjustment range is 0 to 10 (in 1-stop increments).
Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and make the setting.

Select [Unsharp mask]

Drag the slider left or right

Displays the values of the settings

The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view], [100% view] or [50% view]. If the view is set to [Fit to window] (full view), the effects of adjustment may seem unnatural.
Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, automatically adjust the image tone curve (p.143). You can select the degree of automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired automatic adjustment button.

- **Standard**: Standard automatic adjustment. Suitable for most images.
- **High**: Use when the effect achieved in standard automatic adjustment is not strong enough.

Reverts the tone curve to the original settings

Images not suitable for automatic adjustment (tone curve assist)

The result of automatic adjustment (tone curve assist) may not be as expected with the following images:

- Images which have been shot with the proper exposure
- Images where the brightness is unbalanced
- Images which are too dark
- Images which have extreme backlighting

If you click the [ ] button, the tone curve as well as the [Hue] and [Saturation] revert to the default settings. Take care when adjusting the [Hue] and [Saturation] individually (p.107).

The tone curve changes as adjusted.
Editing Efficiently

Editing in the Edit Image Window

The thumbnail display and the edit window are combined and images can be edited efficiently while quickly switching between images to be edited. Images to be edited are selected beforehand in the main window.

1. In the main window, select the images you want to edit.
2. Switch to the edit image window.

   ![Main window and edit image window]

   Click

   → The main window switches to the edit image window.

3. Edit the image.

   ![Edit image window]

   Select the image to be edited
   The selected image is displayed as an enlargement in the middle of the window
   → It may take time for the image to redraw itself.
   ● The same tool palette as in the edit window is displayed and you can edit the image.
   ● To revert to the condition before the last operation performed on the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> + <Z> keys.

By selecting the [View] menu ➔ [AF Point] in the edit window or edit image window, you can display the AF points selected in the camera at the time of shooting. However, AF points are not displayed for images whose image size has been changed and then been converted and saved (p.42, p.134), images for which you selected an effect other than [Shot settings] as correction of fisheye lens distortion aberration, or images which have had settings specified during RAW processing on the camera for distortion correction and chromatic aberration correction.
Double-click the area you want to enlarge.

- The area you double-clicked is enlarged to 100% (actual pixel size).
- To change the display position, drag on the image or drag the enlargement display position (p.128) of the tool palette.
- Double-click again to revert to the full view ([Fit to window]).
- To return to the main window, click the [Main window] button on the toolbar.

To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

- You can change the way the tool palette is displayed (p.92).
- You can change the enlargement ratio when you double-click (p.91).
- With the edit image window, you can only select images from one folder. To gather images from several folders for editing, see “Gathering and Editing Images in the Collection Window” (p.36).
- For a list of edit image window functions, see p.133.
Changing the Thumbnail Display Position to a Horizontal Position

Select the [View] menu ▶ [Change thumbnail position].

If you select [Change thumbnail position] again, the thumbnail display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the [Collection] window for viewing, comparison and editing. You can gather images from several folders as well as from only one folder, allowing you to work with them efficiently.

1. Select images from the [Folder] window in the main window, and select the [File] menu ▶ [Add to collection].

   - The selected images are added to the [Collection] window and the number of selected images is shown on the [Collection] tab sheet.
   - When you add RAW and JPEG images displayed as a single image (p.22), the number of images shown on the [Collection] tab sheet increases by 2.
   - You can select several images and add them to the [Collection] window.
   - You can also add images to the [Collection] window by selecting images, right-clicking with your mouse, and selecting [Add to collection] from the menu that appears.
   - You can add up to 1,000 images to the [Collection] window.
2 Select the [Collection] tab sheet.

![Collection tab sheet](image)

The selected images are displayed in the [Collection] window.

3 Check displayed images in the [Collection] window.

![Collection window](image)

4 Edit the images.

- You can now edit the images displayed in the [Collection] window.

![Collection window](image)

- Images displayed in the [Collection] window are retained in the [Collection] window even after exiting DPP.

To remove images from the [Collection] window

- **Removing randomly selected images**

  Select the images to be removed in the [Collection] window and then select [Remove from collection] in the [File] menu. (You can also remove images from the [Collection] window by selecting the images, right-clicking with the mouse, and selecting [Remove from collection] from the menu that appears.)

  Note that even if you remove an image from the [Collection] window, the original image remains unaffected.

- **Removing all images**

  Select [Clear collection] in the [File] menu. (You can also remove all images from the [Collection] window by selecting one image, right-clicking with the mouse, and selecting [Clear collection] from the menu that appears.)

  Note that even if you remove all images from the [Collection] window, the original images remain unaffected.

**Modifications to the image are applied to the original image**

Modifications made to images added to the [Collection] window are all applied to the original image.

- You can arrange images displayed in the [Collection] window the same way as in the [Folder] window (p.20, p.21). You can maintain the order of rearranged images even after exiting DPP by checkmarking [Retain sort order] on the [View settings] tab sheet in the [Preferences] (p.91).

- You cannot use the following functions in the [Collection] window:

  - Starting of EOS Utility (p.7), or synchronizing of folders with EOS Utility
  - Batch change the file name of images (p.101)
Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the composition of an image where an image shot horizontally becomes vertical. You can also adjust the angle of an image before trimming. If you select [Circle] for [Aspect ratio], the area outside the specified range is only masked in black and the image will not be cropped.

1 Select the image to be trimmed.

2 Open the trimming/angle adjustment window.
   ○ Click the [Trimming Angle] button.

   ➔ The trimming/angle adjustment window appears.
   ➔ Editing can be done once the image is displayed clearly in the trimming/angle adjustment window.

3 Adjust the angle of the image as needed.

Trimming/angle adjustment window

- Use the mouse (click ▲/▼) to adjust the angle or directly enter the adjustment angle* (0.01-degree increments; adjustable range: -45 to +45 degrees)
- Drag* (0.01-degree increments; adjustment range: -45 to +45 degrees)
- Click (rotate image left or right in 90-degree increments)
- Largest possible trimming range

* You cannot adjust the angle of images that exceed 9999 x 6666 pixels in size.

- If you click [Center on Screen], you can display the trimming range in the center of the window.
- When correcting lens aberrations, it is recommended to perform lens aberration correction before adjusting the angle of the image.
- If you click the [OK] button after adjusting only the angle of the image, the image will be trimmed at the largest possible trimming range.

When aspect ratio information is attached to an image shot with the EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS REBEL T3i/600D, the trimming range based on the aspect ratio information is displayed.
4 Select a ratio and drag the trimming range.

- The trimming range can be moved by dragging.
- You can enlarge or reduce the size of the trimming range by dragging the four corners of the trimming range. (Not available when [Circle] is selected.)
- List of aspect ratios (width : height)

<table>
<thead>
<tr>
<th>Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1</td>
</tr>
<tr>
<td>3:2</td>
</tr>
<tr>
<td>2:3</td>
</tr>
<tr>
<td>4:3</td>
</tr>
<tr>
<td>3:4</td>
</tr>
<tr>
<td>5:4</td>
</tr>
<tr>
<td>4:5</td>
</tr>
<tr>
<td>A Size Landscape</td>
</tr>
<tr>
<td>A Size Portrait</td>
</tr>
<tr>
<td>Letter Landscape</td>
</tr>
<tr>
<td>Letter Portrait</td>
</tr>
<tr>
<td>Custom</td>
</tr>
<tr>
<td>Circle</td>
</tr>
</tbody>
</table>

[Free]: You can trim an image to any size, regardless of the selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in black. The image is not trimmed.

5 Click the [OK] button to return to the main window.

- The trimming range frame is displayed in the trimmed image (p.126).
- When the trimmed image is displayed in an edit window or the edit image window, it is displayed in its trimmed form.
**About trimmed images**

* The trimmed range can be reverted to its original condition at any time
  A trimmed image is displayed as a trimmed image. However, since the image is not actually trimmed, you can always revert to the original image by clicking the [Reset] button in the trimming/angle adjustment window or performing the “Re-Editing an Image” procedure (p.43).

* Display of the trimmed image in each window
  - Main window: The frame showing the trimming range is displayed on the image (p.126).
  - Edit window: The image is displayed in its trimmed condition.
  - Edit image window: The thumbnail image is the same as the main window display, and the enlarged image is the same as the edit window display.

* Printing a trimmed image
  You can print as a trimmed image by printing it in DPP.

* The image becomes a trimmed image when converted and saved
  The trimmed RAW image actually becomes a trimmed image when converted to a JPEG or TIFF image and saved (p.42).

* Images that have aspect ratio set will be displayed as trimmed images
  When aspect ratio information is attached to a RAW image shot with EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS REBEL T3i/600D, the set trimming range based on the aspect ratio information is displayed. Since the image is not actually trimmed, you can change the trimming range or revert to the condition before trimming. However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect ratio set with the EOS 5D Mark III, EOS 60D, EOS REBEL T4i/650D or EOS REBEL T3i/600D, its trimming range cannot be changed nor reverted to the condition before trimming, since the image is actually trimmed and saved in the set trimming ratio.*

* Switch between screens using the keyboard
  You can also switch between full screen display/normal screen display by pressing the <Alt> + <Enter> keys or the <F11> key.

* Operate using the menu
  Each operation can also be performed with the menu which appears when you right-click with the mouse on the image.

* Apply the trimmed range to another image
  You can apply the trimmed range to another image by clicking the [Copy] button to copy the trimmed range, displaying another image and then clicking the [Paste] button. To batch apply a copied trimming range to multiple images, select the trimmed image and the multiple images to which you want to apply the trimmed range in the main window, and display the trimming/angle adjustment window. With the trimmed image displayed, click the [Copy] button and then click the [Apply All] button. This will apply the trimming range to all the images selected when the trimming/angle adjustment window is displayed.

To select multiple images in the main window, click the images while holding down the <Ctrl> key. To select multiple consecutive images, click on the first image, and then click on the last image while holding down the <Shift> key.

* Convenient functions of the trimming/angle adjustment window

* Copy

* For images shot with ISO speed range expansion set, noticeable noise may make it difficult to view image details in the trimming/angle adjustment window, so using this function is not recommended.

* For a list of the trimming/angle adjustment window functions, see p.135.
Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the tool palette and apply it to other images. You can efficiently adjust multiple images by adjusting one image and applying the results of this to multiple images shot in similar shooting environment.

1. Select the adjusted image and then select the [Edit] menu ➤ [Copy recipe to clipboard].  
   ➔ The recipe is copied.

2. Select the image to which the recipe is to be applied and then select the [Edit] menu ➤ [Paste recipe].  
   ➔ The recipe is applied to the image.

Saving Editing Results

Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the trimmed (p.38) range information can be saved to a RAW image or to a separate RAW image. The adjustments made with the tool palette (p.56 to p.68) and the dust erase processing explained in Chapter 3 (p.73 to p.77) can also be saved in a RAW image.

Select the [File] menu ➤ desired item.

➔ Your adjustments are saved to the image.

The recipe (p.96) can be saved as a separate file from the image and loaded and applied to another image (p.97).
Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP, convert to a more versatile JPEG or TIFF image and save. The image is saved as a separate image, so the RAW image remains unaffected.

1 Select the image to be converted.

2 Select the [File] menu ➔ [Convert and save].

3 Specify the necessary settings, and then click the [Save] button.

- By default, the image is converted and saved to a JPEG image with the highest image quality, without changing the image size. Change the settings according to your requirements.

The RAW image is converted to a JPEG or TIFF image which is then saved as a new image in the specified save destination.

To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually being improved upon so that you can perform the latest image processing more appropriately. Meaning that, between two differing versions of DPP, processing results may differ very slightly even if with the same RAW image data, or the results of significant editing of RAW image data with an attached recipe may be different. When you want to save the developing or editing results of the version you are currently using as it is, it is recommended that you convert and save images as JPEG image or TIFF images.

- By saving as explained on this page, a trimmed image (p.38) or dust-erased image explained in Chapter 3 (p.73 to p.77) actually becomes a trimmed image or dust-erased image.
- You can reduce the noise characteristic of JPEG images which occurs when you convert and save an image as a JPEG (p.89, p.90).
- You can batch convert and save multiple images (p.99).
- For a list of [Convert and save] window functions, see p.134.
Re-Editing an Image

Only the image processing conditions are changed in images adjusted with the tool palette (p.25 to p.33), so the “original image data itself” remains unaffected. Also, the trimming range information of a trimmed image (p.38) is simply saved to the image. For this reason, you can undo any adjustments saved (p.41) to the image, trimming information, and revert to the condition when last saved, or when the image was shot.

1. Select the image that is to be re-edited.
2. Select the [Adjustment] menu → desired item.

 ejeculta ← The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily with Canon inkjet printers compatible with the Canon printing software, Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print photographs using other printers.

Proceed to the page for the printer you are using.
- Printing Photographs with Canon Inkjet Printers Compatible with Easy-PhotoPrint EX (Same page)
- Printing Photographs with Canon Inkjet Printers Compatible with Easy-PhotoPrint (p.46)
- Printing Photographs with a Printer other than Canon Inkjet Printers (p.49)

Printing Photographs with Canon Inkjet Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP EX”):
- Simple printing of RAW images
- Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1 or later on your computer.
1. Select the image to be printed.

2. Start up EPP EX.
   - Select the [File] menu ➔ [Plug-in printing] ➔ [Print with Easy-PhotoPrint EX].
   - EPP EX starts up.

3. In the EPP EX window, select the [File] menu ➔ [Preferences].
   - The [Preferences] window appears.

4. In [Print Quality], select [Quality Priority], click the [Option] button, and then in the dialog box that appears, checkmark [Print with the best quality when you select [Quality Priority]].
   - Click and checkmark [Print with the best quality when you select [Quality Priority]].
5 Select the [Advanced] tab, check mark [Enable ICC profile], and then click the [OK] button.
→ The [Preferences] window closes.

6 Specify the number of sheets to be printed, and then click [Select Paper].

EPP EX

7 Select the paper type, and then click the [Layout/Print] button.

8 Specify the layout, and then click the [Print] button.
→ Printing begins.
Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When printing more than 1000 images, divide the printing into several jobs.

The printed image's color is not what you expected
In the EPP EX window, select [Preferences] in the [File] menu and then click the [Advanced] tab in the [Preferences] window to display the [Advanced] tab sheet.
In the [Advanced] tab sheet, select [Enable ICC profile] in [Color correction for printing] and try printing using the [Perceptual] setting (p.144).

Advantages of printing with EPP EX

Printing with faithful colors
When the color space (p.144) is set to sRGB or Adobe RGB (p.77, p.93), this color space is automatically transmitted from DPP to EPP EX, allowing you to print with faithful colors.
When the color space is set to Apple RGB or ColorMatch RGB, the image is printed with an sRGB color space, and when set to Wide Gamut RGB, with an Adobe RGB color space.

Printing with a wide color reproduction
When the color space setting (p.77, p.93) is set to Adobe RGB and the image is printed with a Canon inkjet printer, the color reproduction range is wider, and green and blue in particular are reproduced vividly.

DPP is also compatible for printing with Easy-PhotoPrint Pro (p.87).

Printing Photographs with Canon Inkjet Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with Canon inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):

- Simple printing of RAW images
- High quality printing using the color reproduction range of Adobe RGB and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or later on your computer. When using an Easy-PhotoPrint EX-compatible inkjet printer, it is recommended that you print using Easy-PhotoPrint EX (p.43).

1. Select the image to be printed.
2. Start up EPP.
   Select the [File] menu → [Plug-in printing] → [Print with Easy-PhotoPrint].

EPP starts up.
3 In the EPP window, select the [File] menu ▶ [Preferences].

In the EPP window, select the [File] menu ▶ [Preferences].

The [Preferences] window appears.

4 In [Print Quality], select [Quality Priority].

Select the [Print Quality] option and choose [Quality Priority].

5 Select the [Advanced] tab sheet and check that the EPP image compensation function is disabled.

If not disabled, the operation of the EPP image compensation function may prevent images being printed with faithful color reproduction.

If checked, click to remove the check mark.

6 Specify the number of sheets to be printed, and then click [Next].

Select the number of sheets to be printed and click [Next].
7 Check that the image compensation function is disabled, select the paper type and then click [Next].

If checked, click to remove the check marks

Select the paper type

Click

8 Specify the layout, and then click [Print].

Select the layout

Printing begins.

? Additional information

- **Print up to 1000 images at a time**
  You can print up to 1000 images selected in DPP at a time. When printing more than 1000 images, divide the printing into several jobs.

- **The printed image's color is not what you expected**
  Change the [Rendering intents when using Easy-PhotoPrint] (p.93) to [Perceptual] (p.144) and print.

💡 **Printing with a wide color reproduction**

When the color space (p.77, p.93) is set to Adobe RGB and the image is printed with Canon inkjet printer, the color reproduction area widens, and green and blue in particular are reproduced vividly.

When the color space is set to Apple RGB or ColorMatch RGB, the image is printed with an sRGB color space, and when set to Wide Gamut RGB, with an Adobe RGB color space.

DPP is also compatible for printing with Easy-PhotoPrint Pro (p.87).
Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

1. Select the image to be printed.
2. Select the [File] menu ▶ [Print].

- The [Print] dialog box appears.
- Set to photograph printing and print.
  - Specify the optimum settings for photograph printing in the printer’s print settings dialog box and click the [OK] button.
  - Printing begins.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

1. Select an unwanted image in the main window.
2. Select the [File] menu ▶ [Delete].

- The [Confirm File Delete] dialog box appears.
- Click the [Yes] button.
  - The image is moved to the [Recycle Bin] and is deleted from DPP.
  - The images are deleted completely from your computer when the [Empty Recycle Bin] operation is performed on the [Recycle Bin] on the desktop.

Organizing Images

This section explains how to delete unwanted images, create folders for saving images, move or copy images, etc., and organize your images.

Contents at a Glance

Basic Operation

Advanced Operation

Advanced Image Editing and Printing

Processing Large Numbers of Images

Editing JPEG/TIFF Images

Reference

Index
Creating a Folder for Saving Images

You can create a folder for sorting images.

1. In the folder area, select the location where the new folder is to be created.

   ![Folder Creation](image)

2. Select the [File] menu ➔ [Create new folder].

   ![Create New Folder Menu](image)

   ➔ The [Create new folder] dialog box appears.

3. Enter a folder name and click the [OK] button.

   ➔ The new folder is created in the folder selected in step 1.

Moving Images

You can move or copy images to a separate folder and sort by shooting date or themes.

Drag the image to be moved or copied.

- **To move:** Drag the image and release when the image is in the destination folder.
- **To copy:** Drag the image while holding down the <Ctrl> key and release when the image is in the destination folder.

![Moving Images](image)

   ➔ The images are moved or copied to the destination folder.
Moving Images in Folders

You can move or copy folders that contain images, and sort the images by folders.

Drag the folder to be moved or copied.
- **To move:** Drag the folder and release when the folder is in the destination folder.
- **To copy:** Drag the folder while holding down the <Ctrl> key and release when the folder is in the destination folder.

→ The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks. Registered folders appear by clicking the [Bookmark] menu.

1. **Select the folder for which a bookmark is to be registered.**

![Select option]

→ The folder selected in step 1 is registered in the [Bookmark] menu.

- Select a registered folder from the [Bookmark] menu to display images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in [Bookmark].

2. **Select the [Bookmark] menu ▶ [Organize].**

→ The [Sort bookmarks] window appears and you can change folder names or delete folders.

You can register frequently used folders in bookmarks. Registered folders appear by clicking the [Bookmark] menu.

1. **Select the folder for which a bookmark is to be registered.**

![Select option]

→ The folder selected in step 1 is registered in the [Bookmark] menu.

- Select a registered folder from the [Bookmark] menu to display images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in [Bookmark].

2. **Select the [Bookmark] menu ▶ [Organize].**

→ The [Sort bookmarks] window appears and you can change folder names or delete folders.
Various preferences including advanced image adjustment, automatic dust erasure processing, various printing functions for printing out work, and color management are explained here, geared to the user who is competent in the handling of third-party image editing software.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjusting While Comparing with the Original Image...</td>
<td>53</td>
</tr>
<tr>
<td>Changing How the Window is Split</td>
<td>53</td>
</tr>
<tr>
<td>Adjusting by Comparing Multiple Images</td>
<td>54</td>
</tr>
<tr>
<td>Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)</td>
<td>55</td>
</tr>
<tr>
<td>Performing Advanced Editing...</td>
<td>56</td>
</tr>
<tr>
<td>Adjusting White Balance with Color Temperature</td>
<td>56</td>
</tr>
<tr>
<td>Tuning White Balance with Color Wheel</td>
<td>56</td>
</tr>
<tr>
<td>Adjusting Dynamic Range</td>
<td>57</td>
</tr>
<tr>
<td>Adjusting Brightness of Shadows/Highlights</td>
<td>57</td>
</tr>
<tr>
<td>Tone Curve Adjustment</td>
<td>58</td>
</tr>
<tr>
<td>Example of a Tone Curve Operation</td>
<td>59</td>
</tr>
<tr>
<td>Using a Picture Style File</td>
<td>59</td>
</tr>
<tr>
<td>About the RGB Tool Palette</td>
<td>60</td>
</tr>
<tr>
<td>Using the Auto Lighting Optimizer</td>
<td>61</td>
</tr>
<tr>
<td>Reducing Noise</td>
<td>62</td>
</tr>
<tr>
<td>Correcting Lens Aberration...</td>
<td>63</td>
</tr>
<tr>
<td>Compatible Cameras</td>
<td>63</td>
</tr>
<tr>
<td>Compatible Lenses</td>
<td>63</td>
</tr>
<tr>
<td>Making Corrections</td>
<td>65</td>
</tr>
<tr>
<td>Effects of Distortion Aberration Correction for Fisheye Lenses</td>
<td>66</td>
</tr>
<tr>
<td>About Shooting Distance Information Slider</td>
<td>68</td>
</tr>
<tr>
<td>Correcting Multiple Images at a Time</td>
<td>68</td>
</tr>
<tr>
<td>Using the Digital Lens Optimizer</td>
<td>69</td>
</tr>
<tr>
<td>Compatible Cameras</td>
<td>69</td>
</tr>
<tr>
<td>Compatible Lenses</td>
<td>69</td>
</tr>
<tr>
<td>Using the Digital Lens Optimizer</td>
<td>70</td>
</tr>
<tr>
<td>Performing Automatic Dust Erasure Processing</td>
<td>73</td>
</tr>
<tr>
<td>Compatible Cameras</td>
<td>73</td>
</tr>
<tr>
<td>Automatic Dust Erasure Processing in the Main Window</td>
<td>74</td>
</tr>
<tr>
<td>Manually Erasing Dust (Repair Function)</td>
<td>75</td>
</tr>
<tr>
<td>Erasing Unwanted Parts of an Image (Copy Stamp Function)</td>
<td>77</td>
</tr>
<tr>
<td>Transferring a RAW Image to Photoshop</td>
<td>77</td>
</tr>
<tr>
<td>Setting Work Color Space</td>
<td>77</td>
</tr>
<tr>
<td>Compositing Images</td>
<td>78</td>
</tr>
<tr>
<td>Compositing Methods</td>
<td>81</td>
</tr>
<tr>
<td>Creating HDR (High Dynamic Range) Images</td>
<td>81</td>
</tr>
<tr>
<td>Starting Up Map Utility</td>
<td>84</td>
</tr>
<tr>
<td>Printing with Shooting Information</td>
<td>85</td>
</tr>
<tr>
<td>Printing a Thumbnail List (Contact Sheet Printing)</td>
<td>86</td>
</tr>
<tr>
<td>Printing RAW Images on a High-End Canon Printer</td>
<td>87</td>
</tr>
<tr>
<td>Printing with a High-End Canon Inkjet Printer</td>
<td>87</td>
</tr>
<tr>
<td>Printing with a Large-Format Canon Printer</td>
<td>88</td>
</tr>
<tr>
<td>Specifying Preferences</td>
<td>89</td>
</tr>
<tr>
<td>General Settings</td>
<td>89</td>
</tr>
<tr>
<td>View Settings</td>
<td>91</td>
</tr>
<tr>
<td>Tool Palette</td>
<td>92</td>
</tr>
<tr>
<td>Color Management</td>
<td>93</td>
</tr>
</tbody>
</table>
Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the same window and adjust while checking the adjustment results.

1. In the edit window, select the [View] menu ➷ [Before/after comparison].

   ➔ The image divides into a left and right window.
   ➔ The window on the right shows the image after editing.

2. Change the image display.
   ➔ Select the [View] menu ➷ [Change up/down/left/right] ➷ [Up/down].

   ➔ The layout of the two images changes to top and bottom.
   ➔ The bottom window shows the image after editing.

   Images can also be displayed in the edit image window by the same operation.

Changing How the Window is Split

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu ➷ [Display mode] ➷ [Split single image].

   ➔ One image is divided and displayed on the left and right or top and bottom.
   ➔ To switch between top and bottom, and left and right, perform the same operation as step 2 on the left page.
Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and adjust images while comparing them with each other.

1. **In the edit window, display the multiple images to be compared.**

2. **Align the images.**
   - Select the [Window] menu ➔ [Arrange vertically] or [Arrange horizontally].
   - The edit windows are aligned.

3. **Select the [Window] menu ➔ [Synchronize].**

4. **Enlarge the image.**
   - Enlarge and display any of the edit windows.

   ![Multiple images displayed in two rows and two columns.](COPY)

   ➔ The other edit windows will also be displayed in the same position/enlargement ratio.

5. **Move the display position.**
   - If you move the enlargement display position in one of the edit windows, the enlargement display position will also change in the other edit windows.
   - To cancel synchronization, select the [Window] menu ➔ [Synchronize] again.

ℹ️ Synchronization only applies to the enlargement display position and the enlargement ratio. Adjustments to the images are not synchronized.
Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning)

You can set up a warning indicator in both the highlighted part and the shaded part, which is effective for checking the light and dark areas and preventing excessive adjustment of an image. Where the area on the image has exceeded that set range, you can display the highlighted part in red and the shaded part in blue.

1. Select the [Tools] menu ➤ [Preferences].
2. Select the [View settings] tab sheet.
3. Enter the warning value for [Highlight] and [Shadow].
4. Click the [OK] button to close the window.
5. Display the edit window.
6. Select the [View] menu ➤ [Highlight]. Similarly, select [Shadow].

On the opened image, if there is an area that exceeds the value entered in step 3, the highlighted part of that area is displayed in red and the shaded part is displayed in blue.

You can also display the warning with the same operation in the edit image window.
Performing Advanced Editing
This section explains how to use the advanced adjustment function on the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and [RGB] tool palettes, as well as the functions of the [NR/ALO] and [LENS] tool palette are explained in this section.

Adjusting White Balance with Color Temperature
White balance can be adjusted by setting a numerical value for color temperature.

1 Select [Color temperature] from the [White balance adjustment] list box.
2 Set the color temperature.

- The adjustment range is 2500 to 10000K (in 100K units).

Tuning White Balance with Color Wheel
White balance can be tuned by moving a cursor in the color direction shown in the color wheel.

1 In the [RAW] tool palette, click the [Tune] button.
2 Tune by dragging a point.

- You can also fine-tune your adjustment by directly entering the adjustment values.

- To register adjustment results as personal white balance (p.98), select a setting other than [Shot settings] from the [White balance adjustment] list box, and then tune with the color wheel. You cannot register the adjustment results as personal white balance when you have selected [Shot settings] from the list box and have done any tuning.
- You cannot change or adjust white balance with multiple-exposure RAW images created on the camera.

- The adjustment range of color tone is 0 to 359 (1 unit in numerical value input), and the adjustment range of color saturation is 0 to 255 (1 unit in numerical value input).
**Adjusting Dynamic Range**

Dynamic range (width of gradation expression) from dark points to bright points in an image can be adjusted.

- Move to the left or right to input highlight points.
- Move downwards to output highlight points.
- Move upwards to output shadow points.
- Move to the left or right to input shadow points.

The horizontal axis shows the input level and the vertical axis shows the output level.

**Adjusting Brightness of Shadows/Highlights**

You can adjust the brightness of shadows and highlights in an image. By adjusting shadows and highlights in an image with a restricted brightness, you can reduce the effects of clipping in shadows and highlights.

- Drag the sliders left or right.

You can adjust the brightness of shadows and highlights in an image.
**Tone Curve Adjustment**

You can adjust the brightness, contrast and color of a specific area by changing the tone curve (p.143).

1. In the tool palette, select the [RGB] tab sheet.
2. Select the tone curve mode and interpolation method.

![Tone Curve Adjustment](image)

- Right-click with the mouse inside the graph to display the menu.
- Click to add a [ ] (point) and adjust by dragging [ ].
- Adjusts each channel and batch adjusts RGB.
- The horizontal axis shows the input level and the vertical axis shows the output level.
- The maximum number of [ ] is 8.
- To delete a [ ], either press the <Del> key or double-click on the [ ].

- The histogram display changes according to adjustment. You can also fix the histogram display to the display before any adjustments (p.92).
- The tone curve mode and interpolation method for a tone curve can also be changed in [Preferences] (p.92).
Example of a Tone Curve Operation

- Makes medium tones brighter
- Makes medium tones darker
- Makes tones harder
- Makes tones softer

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style. With DPP, you can apply to RAW images Picture Style files that you have downloaded from Canon’s web site effective for various scenes or Picture Style files created with “Picture Style Editor”. When using a Picture Style file, save it to your computer beforehand.

1. Display the image to which the Picture Style file is to be applied in the edit window (p.11).
2. Select the [RAW] tab sheet in the tool palette, and click the [Browse] button.
   → The [Open] dialog box appears.
3. Select a Picture Style file saved on your computer, and click the [Open] button.
   → The Picture Style file you selected is applied to an image.
   • To apply a different Picture Style file, follow the procedure from step 2 again.

The Picture Style files that you can apply to the camera are files with the “.PF2” extension only. Furthermore, you cannot apply Picture Style files with the extension “.PSE” to an image; however if such a file is registered in the camera and the image is shot, the image will display correctly.
About the RGB Tool Palette

You can adjust images with the tool palette by switching between the [RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your editing requirements.

The [RGB] tool palette functions are the same as ordinary image editing software, such as tone curve adjustment that is explained here, with which you can adjust RAW images. However, because the adjustment width of the functions in the [RGB] tool palette is wider than the [RAW] tool palette, the image color may be saturated, or the image quality may deteriorate if you adjust too much. Therefore we recommend for functions other than tone curve adjustment (p.58) and automatic adjustment (p.33), that you adjust images using the same functions available in the [RAW] tool palette. See Chapter 5 for explanations on functions of the [RGB] tool palette other than tone curve adjustment.

Using the tool palette

We recommend that as a general principle you edit RAW images using the [RAW] tool palette. However, where the adjustment width with the [RAW] tool palette is not wide enough and you wish to use the special functions in the [RGB] tool palette, we recommend that you adjust your images at the necessary lowest limit with the [RGB] tool palette after having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/ALO] and [LENS] tool palette (p.129) when applying the Auto Lighting Optimizer (p.61), reducing noise (p.62) or correcting aberration (p.63) after you have made any required adjustments with the [RAW] and [RGB] tool palettes.
Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto Lighting Optimizer function to auto-correct the brightness and contrast, and obtain a more pleasant image.

You can also change the settings of the image shot with the camera’s Auto Lighting Optimizer function.

This function is compatible only with RAW images shot with EOS-1D X, EOS-1D Mark IV, EOS 5D Mark III, EOS 5D Mark II, EOS 7D, EOS 60D, EOS 50D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D, EOS REBEL T1i/500D and EOS REBEL T3/1100D.

* ALO stands for Auto Lighting Optimizer.

1. Select the [NR/ALO] tab sheet from the tool palette in the edit window or edit image window.

2. Checkmark the checkbox.

   Checkmark

   - For images shot with the camera’s Auto Lighting Optimizer function, the checkbox is already checked.

3. Change the settings according to your preferences.

   Select from three levels: Low/Standard/Strong

   - Auto correction is applied to the image to match the settings.
   - For images shot with the camera’s Auto Lighting Optimizer function, the settings at the time of shooting are applied as the default values.
   - To cancel the Auto Lighting Optimizer, remove the check mark from the checkbox.

   * When [Highlight tone priority] is set to [Enable] in EOS-1D X, EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D and EOS REBEL T3/1100D, the Auto Lighting Optimizer function cannot be set.
   * You cannot use the Auto Lighting Optimizer with multiple-exposure RAW images created on the camera.
Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a high ISO speed. NR is an abbreviation for “noise reduction”.

1. Select the [NR/ALO] tab sheet from the tool palette in the edit window or edit image window.
2. Click the [NR Preview] button. 

   The [NR Preview] window appears.
3. Adjust an image.

   - You can set a noise reduction level from within a range of 0 to 20. The larger the setting, the larger the noise reduction effect.
   - The noise reduction effect can be checked when an image is displayed at 100% in the NR check window.
   - You can change the display position of the NR check window by dragging the enlargement display position in the navigator window.

4. Click the [Apply] button.

   Noise reduction is applied to the image and the image is redisplayed.

   - The noise reduction function does not work

   Noise reduction cannot be applied when [Viewing and saving RAW images] (p.89) is set to [High speed] in the [Preferences] window. Select [High quality] to reduce noise.

   - To set the same noise reduction level for several images

   After selecting multiple images in the main window, you can set the same noise reduction level for the images without displaying the [NR Preview] window, by adjusting the noise reduction level in the [NR/ALO] tool palette (p.129) using the [Luminance noise reduction] and [Chrominance noise reduction] sliders, and then clicking the [Apply] button.

     - When [Apply camera settings] is selected, you can pre-set a noise reduction level that suits the camera settings beforehand as the default.
     - When [Set as defaults] is selected, you can pre-set a preferred default setting for the noise reduction level beforehand. This is particularly useful for applying noise reduction to all the images in a folder at once, such as batch noise reduction for images with high ISO speeds.

   However, for images with recipes attached, the noise level recorded in the recipe will be applied.

   - If [Luminance noise reduction] has been set, resolution may be reduced along with reduction of noise.
   - If [Chrominance noise reduction] has been set, color bleeding may occur along with reduction of noise.

   For a list of [NR Preview] window functions, see p.131.
Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination, distortions in the subject, and color blur which occur by the physical characteristics of the lens or slightly remaining aberration. Please note that you can only correct RAW images which have been taken with the compatible cameras and lenses listed below. JPEG or TIFF images cannot be corrected.

Compatible Lenses

<table>
<thead>
<tr>
<th>Fisheye, ultra wide, and wide angle lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 14mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 8-15mm f/4L USM Fisheye*3</td>
</tr>
<tr>
<td>EF 20mm f/2.8 USM</td>
</tr>
<tr>
<td>EF 24mm f/1.4L II USM*3</td>
</tr>
<tr>
<td>EF 24mm f/2.8 IS USM*3</td>
</tr>
<tr>
<td>EF 28mm f/2.8</td>
</tr>
<tr>
<td>EF 35mm f/1.4L USM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard and medium telephoto lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 50mm f/1.2L USM*4</td>
</tr>
<tr>
<td>EF 50mm f/1.8</td>
</tr>
<tr>
<td>EF 85mm f/1.2L USM</td>
</tr>
<tr>
<td>EF 85mm f/1.8 USM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Telephoto lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 135mm f/2L USM</td>
</tr>
<tr>
<td>(with Softfocus mechanism)</td>
</tr>
<tr>
<td>EF 200mm f/2L IS USM*3</td>
</tr>
<tr>
<td>EF 200mm f/2.8L II USM</td>
</tr>
<tr>
<td>EF 300mm f/2.8L IS USM</td>
</tr>
<tr>
<td>EF 400mm f/2.8L IS USM</td>
</tr>
<tr>
<td>EF 400mm f/5.6L USM</td>
</tr>
<tr>
<td>EF 500mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 600mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 800mm f/5.6L IS USM*3</td>
</tr>
</tbody>
</table>

Compatible Cameras

<table>
<thead>
<tr>
<th>EOS-1D X</th>
<th>EOS-1D Mark IV</th>
<th>EOS-1Ds Mark III</th>
</tr>
</thead>
<tbody>
<tr>
<td>EOS-1D Mark II</td>
<td>EOS-1Ds</td>
<td>EOS-1D</td>
</tr>
<tr>
<td>EOS 5D Mark III</td>
<td>EOS 5D</td>
<td>EOS 5D*1</td>
</tr>
<tr>
<td>EOS 7D</td>
<td>EOS 60D</td>
<td>EOS 50D</td>
</tr>
<tr>
<td>EOS 40D</td>
<td>EOS 30D*2</td>
<td>EOS REBEL T4i/650D</td>
</tr>
<tr>
<td>EOS REBEL T3i/600D</td>
<td>EOS REBEL T2i/550D</td>
<td>EOS REBEL T1i/500D</td>
</tr>
<tr>
<td>EOS DIGITAL REBEL XSi/450D</td>
<td>EOS DIGITAL REBEL XTi/400D DIGITAL</td>
<td>EOS REBEL T3/1100D</td>
</tr>
<tr>
<td>EOS DIGITAL REBEL XS/1000D</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

<table>
<thead>
<tr>
<th>Fisheye, ultra wide, and wide angle lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 14mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 8-15mm f/4L USM Fisheye*3</td>
</tr>
<tr>
<td>EF 20mm f/2.8 USM</td>
</tr>
<tr>
<td>EF 24mm f/1.4L II USM*3</td>
</tr>
<tr>
<td>EF 24mm f/2.8 IS USM*3</td>
</tr>
<tr>
<td>EF 28mm f/2.8</td>
</tr>
<tr>
<td>EF 35mm f/1.4L USM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard and medium telephoto lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 50mm f/1.2L USM*4</td>
</tr>
<tr>
<td>EF 50mm f/1.8</td>
</tr>
<tr>
<td>EF 85mm f/1.2L USM</td>
</tr>
<tr>
<td>EF 85mm f/1.8 USM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Telephoto lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 135mm f/2L USM</td>
</tr>
<tr>
<td>(with Softfocus mechanism)</td>
</tr>
<tr>
<td>EF 200mm f/2L IS USM*3</td>
</tr>
<tr>
<td>EF 200mm f/2.8L II USM</td>
</tr>
<tr>
<td>EF 300mm f/2.8L IS USM</td>
</tr>
<tr>
<td>EF 400mm f/2.8L IS USM</td>
</tr>
<tr>
<td>EF 400mm f/5.6L USM</td>
</tr>
<tr>
<td>EF 500mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 600mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 800mm f/5.6L IS USM*3</td>
</tr>
<tr>
<td>Zoom lenses</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>EF 16-35mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 17-35mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 20-35mm f/3.5-4.5 USM</td>
</tr>
<tr>
<td>EF 24-70mm f/2.8L II USM*3</td>
</tr>
<tr>
<td>EF 24-105mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 28-90mm f/4-5.6 USM</td>
</tr>
<tr>
<td>EF 28-90mm f/4-5.6</td>
</tr>
<tr>
<td>EF 28-105mm f/3.5-4.5 USM</td>
</tr>
<tr>
<td>EF 28-105mm f/3.5-4.5 II USM</td>
</tr>
<tr>
<td>EF 28-105mm f/4-5.6</td>
</tr>
<tr>
<td>EF 28-105mm f/4-5.6 II</td>
</tr>
<tr>
<td>EF 28-105mm f/3.5-4.5 II USM</td>
</tr>
<tr>
<td>EF 28-200mm f/3.5-5.6</td>
</tr>
<tr>
<td>EF 28-200mm f/3.5-5.6 II</td>
</tr>
<tr>
<td>EF 28-300mm f/3.5-5.6L IS USM</td>
</tr>
<tr>
<td>EF 55-200mm f/3.5-5.6 II</td>
</tr>
<tr>
<td>EF 20-200mm f/3.5-5.6</td>
</tr>
<tr>
<td>EF 20-200mm f/3.5-5.6 II</td>
</tr>
<tr>
<td>EF 70-200mm f/2.8L IS USM</td>
</tr>
<tr>
<td>EF 70-200mm f/2.8L II USM</td>
</tr>
<tr>
<td>EF 70-300mm f/4-5.6 IS USM*3</td>
</tr>
<tr>
<td>EF 70-300mm f/4-5.6</td>
</tr>
<tr>
<td>EF 70-300mm f/4-5.6 DO IS USM</td>
</tr>
<tr>
<td>EF 75-300mm f/4-5.6 IS USM*3</td>
</tr>
<tr>
<td>EF 75-300mm f/4-5.6</td>
</tr>
<tr>
<td>EF 90-300mm f/4-5.6</td>
</tr>
<tr>
<td>EF 100-300mm f/4-5.6</td>
</tr>
<tr>
<td>EF 100-300mm f/4-5.6 IS USM</td>
</tr>
</tbody>
</table>

**Macro lenses**

| EF 50mm f/2.5 Compact Macro*3 | EF 100mm f/2.8 Macro USM |
| EF 100mm f/2.8L Macro IS USM*3 | EF 180mm f/3.5L Macro USM |
| MP-E 65mm f/2.8 1-5x Macro Photo*3 | |

Aberration correction will not apply to images shot with a combination of lenses *3 *4 *5 and EOS 5D or EOS 30D with the firmware versions below.

* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with firmware version 1.0.5 or earlier

*4 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with firmware version 1.0.4 or earlier

*5 EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with firmware version 1.0.4 or earlier

- You can also correct RAW images taken with the compatible lens even when the extender is attached.
- You can also correct RAW images shot with EF 50mm f/2.5 Compact Macro fitted with Life Size Converter EF.
- The aberration correction function is not available for images shot with combinations of camera/lens other than those given under “Compatible Cameras” and “Compatible Lenses”. They are therefore not displayed and cannot be used.
- The chromatic aberration correction function is not available for multiple-exposure RAW images created on the camera.
Making Corrections

You can make corrections to any of the four aberrations as below, either one at a time or simultaneously.

- Peripheral illumination
- Chromatic aberration (color fringing which occurs in the periphery of an image)
- Color blur (blue or red color blur which sometimes occurs at the edge of the highlighted area of an image)
- Distortions

1. In the tool palette, select the [LENS] tab sheet.

2. Click the [Tune] button.

   - The [Lens aberration correction] window appears.

3. Checkmark the items to be corrected.

   - The image is corrected and redisplayed.
   - Check the results of corrections to peripheral illumination or distortions in the full view.
   - Check the results of corrections to chromatic aberration and color blur by clicking the area on the image you want to check. In the top right of the window, the area is displayed at 200% in the enlargement display section (p.136).
   - You can lessen the degree of correction by moving the slider to the left for the item you want to correct.
   - You can respectively correct red chromatic aberration with the [R] slider of the [Chromatic aberration] or blue chromatic aberration with the [B] slider.
   - To correct distortion aberration of images shot with a fisheye lens (EF 8–15mm f/4L USM Fisheye or EF 15mm f/2.8 Fisheye), four effects can be selected from the [Effect] list box in addition to [Shot settings] normally used for distortion correction. The level of an effect can be adjusted with the adjustment slider located below [Distortion]. For detailed information on each effect, see "Effects of Distortion Aberration Correction for Fisheye Lenses" (p.66).
For images shot with EF 8–15mm f/4L USM Fisheye, a fine-tune slider is also displayed when you select [Emphasize Linearity] from the [Effect] list box. Adjust the amount of correction for distortion aberration with the adjustment slider, and then adjust with the fine-tune slider if more adjustment is required.

When the list box for selecting an extender is displayed, select the extender attached at the time of shooting from the list box.

4 Click the [OK] button.

➢ The [Lens aberration correction] window closes and the result of the corrections is applied to the image in the edit window and the image is redisplayed.
➢ The result of the settings of the [Lens aberration correction] window is also displayed in the tool palette.
➢ In the main window, the [ ] mark is displayed on the image to indicate the lens aberration corrections (p.126).

Effects of Distortion Aberration Correction for Fisheye Lenses

➢ Shot settings

By selecting this option, only distortion aberration correction for correcting optical distortion is performed.

Emphasize Linearity

This converts the image to a “central projection” style image. This projection method is used with general lenses. Differing from fisheye lenses, central projection displays straight lines as straight lines. By selecting this option, a wide-view panoramic image can be obtained. However, the periphery is stretched, resulting in decreased resolution.
Emphasize Distance
This converts the image to an "equidistant projection" style image. This projection method preserves distance relationships. Equidistant projection displays the same distances from the center to the periphery as the same distances. In particular, when shooting a celestial body such as the celestial sphere, any height above the horizon (declination) is captured at an equal interval. This method is therefore used in such photography as celestial photography (star maps, solar path diagrams, etc.).

Emphasize Periphery
This converts the image to a "stereographic projection" style image. This projection method emphasizes the periphery. Stereographic projection allows position relationships on a spherical surface, such as N, S, E, W on a map, to be displayed correctly. It is therefore used for world maps and monitoring cameras. By selecting this option, the periphery is stretched and may result in decreased resolution.

Emphasize Center
This converts the image to an "orthogonal projection" style image. With this projection method, the center is more emphasized. Since an orthogonal projection allows a subject of the same brightness to be displayed as occupying the same area in the image, this method has typical uses in photography for celestial luminance distributions and center-emphasized animal photography. By selecting this option, the center is stretched and may result in decreased resolution.

While selecting any of the options [Emphasize Linearity], [Emphasize Distance], [Emphasize Periphery], or [Emphasize Center] will yield results similar to each of the projection methods, the conversion does not exactly apply each projection method in their precise sense. Accordingly, care should be taken since they are not suited to scientific or other such purposes.
### About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below, if shooting distance information has been saved to the image, the slider is set automatically according to this shooting distance information. However, if no shooting distance information is saved to the image, the slider is set automatically to the right end at infinity position and a [>] appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust the distance by operating the slider while looking at the screen.

<table>
<thead>
<tr>
<th>Canon EOS-1D X</th>
<th>Canon EOS-1D Mark IV</th>
<th>Canon EOS-1Ds Mark III</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canon EOS-1D Mark III</td>
<td>Canon EOS 5D Mark III</td>
<td>Canon EOS 5D Mark II</td>
</tr>
<tr>
<td>Canon EOS 7D</td>
<td>Canon EOS 60D</td>
<td>Canon EOS 50D</td>
</tr>
<tr>
<td>Canon EOS 40D</td>
<td>Canon EOS REBEL T4i/650D</td>
<td>Canon EOS REBEL T3i/600D</td>
</tr>
<tr>
<td>Canon EOS REBEL T2i/550D</td>
<td>Canon EOS REBEL T1i/500D</td>
<td>Canon DIGITAL REBEL XSi/450D</td>
</tr>
<tr>
<td>Canon EOS REBEL T3i/1100D</td>
<td>Canon DIGITAL REBEL XSi/1000D</td>
<td>—</td>
</tr>
</tbody>
</table>

### Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool palette by clicking the [Tool Palette] button (p.124) in the toolbar. If you perform correction procedures (p.65) when tool palette is displayed, you can apply the same corrections to all the images selected in the main window. Also, you can apply same corrections by copying the recipe of the corrected image and pasting it onto the multiple images (p.41).

? Additional information

- **Some noise appeared in the periphery of an image after correcting [Peripheral illumination]**
  
  You can reduce the noise by using luminance and/or chromatic noise reduction of the noise reduction function (p.62). However, if you had applied high amount of [Peripheral illumination] correction to the images that have been shot at night or with a high ISO speed, the noise might not be reduced.

- **The image appears with less resolution after correcting [Distortion]**
  
  You can make the image similar to the one before correction by applying more sharpness with the sharpness adjusting function (p.31).

- **The colors of the image became weaker after correcting [Color blur]**
  
  You can make the image similar to the one before correction by adjusting the color tone (p.29) and/or the color saturation (p.107) to make the color deeper.

- **The result of [Color blur] correction cannot be detected**
  
  [Color blur] correction is effective for correcting blue or red color blur which occurs at the edge of the highlighted area of an image. If conditions do not match, correction cannot be made.

⚠️ The periphery of the image may be truncated when [Distortion] correction is made.

For a list of the [Lens aberration correction] window functions, see p.136.
Using the Digital Lens Optimizer

This function enables the resolution of images to be increased by removing any remaining aberration related to image-forming capability or any deterioration of resolution resulting from diffraction phenomena that are unavoidable as long as light must pass through the lens. These optical phenomena cannot be corrected under [Lens aberration correction] (p.63). Correction is achieved using the designed value of each lens. The images that can be corrected are RAW images shot using any of the following “compatible cameras” and “compatible lenses”. JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected. To use this function, [Lens data] for the lens used to shoot images first needs to be downloaded to your computer.

Before using the Digital Lens Optimizer, it is recommended that you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0.

Compatible Cameras

<table>
<thead>
<tr>
<th>EOS-1D X</th>
<th>EOS-1D Mark IV</th>
<th>EOS-1Ds Mark III</th>
</tr>
</thead>
<tbody>
<tr>
<td>EOS-1D Mark III</td>
<td>EOS-1D Mark II N</td>
<td>EOS-1Ds Mark II</td>
</tr>
<tr>
<td>EOS-1D Mark II</td>
<td>EOS-1Ds</td>
<td>EOS-1D</td>
</tr>
<tr>
<td>EOS 5D Mark III</td>
<td>EOS 5D Mark II</td>
<td>EOS 5D*1</td>
</tr>
<tr>
<td>EOS 7D</td>
<td>EOS 60D</td>
<td>EOS 50D</td>
</tr>
<tr>
<td>EOS 40D</td>
<td>EOS 30D*2</td>
<td>EOS REBEL T4i/650D</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EOS REBEL T3i/600D</th>
<th>EOS REBEL T2i/550D</th>
<th>EOS REBEL T1i/500D</th>
</tr>
</thead>
<tbody>
<tr>
<td>EOS DIGITAL REBEL XSi/450D</td>
<td>EOS DIGITAL REBEL XTi/400D DIGITAL</td>
<td>EOS REBEL T3/1100D</td>
</tr>
</tbody>
</table>

| EOS DIGITAL REBEL XS/1000D |       |       |

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

<table>
<thead>
<tr>
<th>Wide angle lenses</th>
<th>Standard and medium telephoto lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 14mm f/2.8L II USM</td>
<td>EF 24mm f/1.4L II USM</td>
</tr>
<tr>
<td>EF 35mm f/1.4L USM</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Telephoto lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 50mm f/1.4 USM</td>
</tr>
<tr>
<td>EF 85mm f/1.2L II USM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Zoom lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF 16-35mm f/2.8L USM</td>
</tr>
<tr>
<td>EF 17-40mm f/4L USM</td>
</tr>
<tr>
<td>EF 24-70mm f/2.8L II USM</td>
</tr>
<tr>
<td>EF 28-300mm f/3.5-5.6L USM</td>
</tr>
<tr>
<td>EF 70-200mm f/2.8L IS II USM</td>
</tr>
<tr>
<td>EF 70-200mm f/4L IS USM</td>
</tr>
<tr>
<td>EF 100-400mm f/4.5-5.6L IS USM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EF-S lenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>EF-S 10-22mm f/3.5-4.5 USM</td>
</tr>
<tr>
<td>EF-S 17-55mm f/2.8 IS USM</td>
</tr>
<tr>
<td>EF-S 18-135mm f/3.5-5.6 IS</td>
</tr>
<tr>
<td>EF-S 18-200mm f/3.5-5.6 IS</td>
</tr>
</tbody>
</table>

● The Digital Lens Optimizer is not available for images shot with an extender mounted on a compatible lens.
● You cannot use the Digital Lens Optimizer with multiple-exposure RAW images created on the camera.

* Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6
Using the Digital Lens Optimizer

1. In the tool palette, select the [LENS] tab sheet, and check the status of [Lens data] for [Digital Lens Optimizer].

   ![Digital Lens Optimizer Window]

   - [Not Available] is displayed for an image shot with a non-compatible camera or lens, or for a non-compatible image such as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot be used for these images.
   - If [No] is displayed, proceed to step 2. To use the function, you need to download [Lens data] for the lens used when shooting the image. It is recommended that you check the lens used when shooting the image beforehand. The lens used can be checked using the [Info] button in the toolbar on the main window (p.23). You can also check it with the menu that appears when you right-click with the mouse on an image.
   - If [Yes] is displayed, proceed to step 4.

   ! Before you click the [Update] button in step 2, Lens data [No] may be displayed instead of [Not Available] for non-compatible images.

2. Click the [Update] button.

   ![Update Button]

   The [Add or Remove lens data] window appears.

   - To use this function, an environment with Internet access (subscription to a provider, browser software installed and an in-place line connection) is required.
   - An administrator-level privilege is required for this operation.
3 Checkmark the checkbox for the lens used to shoot the image, and click the [Start] button.

- The lens data is downloaded to your computer.
- When the downloading of the lens data ends, the indication for [Lens data] changes to [Yes].
- You can download the data for several lenses at the same time.
- If you remove the check mark from the checkbox for already-downloaded lens names and click the [Start] button, the lens data will be deleted from your computer.

⚠ Depending on the type, current state, etc. of software running on your computer, the download of the lens data may fail. If it occurs, wait for a while then try downloading the data again.

4 Click the [Tune] button.

The [Digital Lens Optimizer] window appears.
5 Checkmark the [Setting] checkbox and adjust the image.

- The [Setting] checkbox will be checkmarked if the image has the Digital Lens Optimizer already applied. Remove the checkmark and click the [Save] button to cancel the Digital Lens Optimizer.
- In the [Digital Lens Optimizer] window, images are displayed with [Sharpness] and [Unsharp mask] effects applied.

6 Click the [Save] button.

- The [Digital Lens Optimizer] window closes and correction results are applied to the image in the edit window.
- Corrections made in the [Digital Lens Optimizer] window are also displayed in the tool palette.
- In the main window, the [ ] mark is displayed on the image to indicate that the Digital Lens Optimizer is applied (p.126).
- After clicking the [Save] button, the application of the corrections to the image may take some time.
- The size of the image file will be larger after applying the Digital Lens Optimizer.
Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera that can attach this data, can be used to automatically erase dust spots.

In the main window, select an image appended with Dust Delete Data.

1. In the main window, select an image appended with Dust Delete Data.

2. Click the [Stamp] button.

Don’t use the copy stamp function, as the copy stamp window appears.

3. When the image has redrawn itself, click the [Apply Dust Delete Data] button.

→ Dust spots are erased in a single operation.

4. Click the [OK] button to return to the main window.

→ The [ ] mark (p.126) is displayed on an image from which dust spots have been erased.

Compatible Cameras

<table>
<thead>
<tr>
<th>EOS-1D X</th>
<th>EOS-1D Mark IV</th>
<th>EOS-1Ds Mark III</th>
</tr>
</thead>
<tbody>
<tr>
<td>EOS-1D Mark III</td>
<td>EOS 5D Mark III</td>
<td>EOS 5D Mark II</td>
</tr>
<tr>
<td>EOS 7D</td>
<td>EOS 60D</td>
<td>EOS 50D</td>
</tr>
<tr>
<td>EOS 40D</td>
<td>EOS REBEL T4i/650D</td>
<td>EOS REBEL T3i/600D</td>
</tr>
<tr>
<td>EOS REBEL T2i/550D</td>
<td>EOS REBEL T1i/500D</td>
<td>EOS DIGITAL REBEL XSi/450D</td>
</tr>
<tr>
<td>EOS DIGITAL REBEL XTi/400D DIGITAL</td>
<td>EOS REBEL T3/1100D</td>
<td>EOS DIGITAL REBEL XS/1000D</td>
</tr>
</tbody>
</table>
The dust-erased image can be reverted to its original condition at any time
A dust-erased image is displayed or printed as a dust-erased image. However, since the dust on the image is not actually erased, you can always revert to the original image by clicking the [Undo] button in the copy stamp window or performing the “Re-Editing an Image” procedure (p.43).

Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust erasure are displayed in other windows and you will be unable to check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the camera, if there is no dust to remove by DPP from the image, the [Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic dust erasure processing
In automatic dust erasure processing, dust spots are erased based on information relating to dust saved in the Dust Delete Data. However, there may be cases where you will not be able to erase dust spots depending on the type of dust. If this occurs, erase those dust spots using the repair function (p.75) or the copy stamp function (p.77).

The image becomes a dust-erased image when converted and saved
The dust-erased RAW image actually becomes a dust-erased image when converted to a JPEG or TIFF image and saved (p.42).

Checking the dust erased spots
After step 3, you can display and check in detail the erased dust spots one by one by pressing the <Shift> + <F> keys. (Press the <Shift> + <B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only
After step 3, you can press the <Shift> + <F> keys or the <Shift> + <B> keys to display the erased dust spot, and then press the <Shift> + <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using shortcut keys
You can also switch between full screen display/normal screen display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image
You can apply dust erasure to the same place in another image by clicking the [Copy] button to copy the dust erasure results and then displaying the other image to which you want to apply the results and clicking the [Paste] button.

For a list of the copy stamp window functions, see p.140.

Automatic Dust Erasure Processing in the Main Window
In the main window, you can also automatically erase dust spots in multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete Data, and then select the [Adjustment] menu ➔ [Apply Dust Delete Data].
➔ Dust spots in all the selected images are erased in a single operation.
Manually Erasing Dust (Repair Function)
You can erase dust spots in an image by selecting them one by one.

1. In the main window, select the image you want to erase dust spots.
2. Click the [Stamp] button.
   → The copy stamp window appears.
3. When the image has redrawn itself, double-click the point from where dust is to be erased.
   → The display changes to 100% view.
   • The display position can be changed by dragging.
4. Click the button that matches the dust spot to be erased.
   • If the dust spot is dark in color, click the [ ] button, and if the dust spot is light in color, click the [ ] button.
   • When you move the cursor over the image, the dust erasure range appears as [ ].
5. Place the dust spot to be erased within the [ ] and click.
   → The dust spot within the [ ] is erased.
   • Click on another part of the image to continue erasing dust spots in the image.
   • To erase dust in another part of the image, either right-click with the mouse, or click the button clicked in step 4 again to cancel dust erasure processing and perform the operation again from step 3.
   • When the dust spot cannot be erased, [ ] is displayed.
6. Click the [OK] button to return to the main window.
   → The [ ] mark (p.126) is displayed on an image from which dust spots have been erased.
Additional information

- **Click several times when dust spots are not erased completely**
  Where unwanted dust spots are not erased even after performing step 5 once, they may be erased completely when you click several times.

- **Mainly spots of dust can be erased with the repair function**
  Spots of dust can be erased with the repair function. You may be unable to erase lines of dust. In this case, use the copy stamp function (p.77).

- **The dust-erased image can be reverted to its original condition at any time**
  A dust-erased image is displayed or printed as a dust-erased image. However, since the dust on the image is not actually erased, you can always revert to the original image by clicking the [Undo] button in the copy stamp window or performing the "Re-Editing an Image" procedure (p.43).

- **Check dust erasure in the copy stamp window**
  Check dust erasure in the copy stamp window. Images before dust erasure are displayed in other windows and you will be unable to check them.

- **Printing dust-erased images**
  You can print as a dust-erased image by printing it in DPP.

- **The image becomes a dust-erased image when converted and saved**
  The dust-erased RAW image actually becomes a dust-erased image when converted to a JPEG or TIFF image and saved (p.42).

Useful functions of the copy stamp window

- **Checking the dust erased spots**
  After step 5, you can display and check in detail the erased dust spots one by one by pressing the <Shift> + <F> keys. (Press the <Shift> + <B> keys to return to the previous dust spot.)

- **Canceling a specified erased dust spot only**
  After step 5, you can press the <Shift> + <F> keys or the <Shift> + <B> keys to display the erased dust spot, and then press the <Shift> + <Del> keys to cancel only the erased dust spot displayed.

- **Switch between full screen display/normal screen display using shortcut keys**
  You can also switch between full screen display/normal screen display by pressing the <Alt> + <Enter> keys.

- **Applying the dust erasure result to another image**
  You can apply dust erasure to the same place in another image by clicking the [Copy] button to copy the dust erasure results and then displaying the other image to which you want to apply the results and clicking the [Paste] button. To apply dust erasure to the same place in several other images, you can efficiently erase dust spots by clicking the images while holding down the <Ctrl> key in the main window, or, by selecting multiple images by clicking the first image and then clicking the last image while holding down the <Shift> key, and then displaying the copy stamp window.

- **For images shot with ISO speed range expansion set, noticeable noise may make it difficult to view dust spots in the copy stamp window, so using this function is not recommended.**

For a list of the copy stamp window functions, see p.140.
Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part of the image to an unwanted part of the image.

1. Follow steps 1 to 3 in “Manually Erasing Dust (Repair Function)” (p.75).

2. Specify the section to be copied.
   - Click on the section that is to be the copy source while holding down the <Alt> key.
   - To change the section that is to be the copy source, perform the operation above again.
   - To fix the position of the copy source, checkmark [Fix Copy Source position].

3. Correct the image.
   - Click or drag on the section you want to correct on the image. [+] in the window indicates the copy source and [ ] indicates the copy destination.
   - The copied image is pasted in the position to which it was dragged.
   - For [Pen type], you can select from [Brush] (the pasted image’s borders simulate a brush) and [Pencil] (the pasted image’s borders are sharp).

4. Click the [OK] button to return to the main window.
   - The [ ] mark (p.126) is displayed on a corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred to Photoshop.

Select the [Tools] menu ▹ [Transfer to Photoshop].
   ➔ Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at a time, see p.100.

- Compatible versions of Photoshop are 7.0 or later.
- Transferred images are automatically converted to TIFF images (16bit) to which an ICC profile (p.143) is added. The ICC profile contains information about [Preferences] (p.93) or work color space set for each image as described below and the appropriate color information is relayed to Photoshop.
- When you exit Photoshop, only the original RAW image remains, and the transferred image will disappear. Saving the transferred image as a separate image in Photoshop is highly recommended.
- For CS4 or later versions of Photoshop, this function is not available if a 32-bit version is not installed.

Setting Work Color Space

A different work color space (p.144) from the default settings (p.93) can be set for each image.

Select the [Adjustment] menu ▹ [Work color space] ▹ color space to be set.

? A color space set individually does not change even when the default setting is changed

If you set an image with a color space different to the default setting and then subsequently change the default color space setting (p.93), this default setting will not be applied and the individually set color space will remain.

💡 The color space of a RAW image can be changed freely as many times as required

Since only the image processing conditions information changes, the color space of a RAW image can be changed at any time.
Compositing Images

You can combine two images into a single image. You can further combine images by adding another image to the composited image. Since the composited image is saved as a separate image, the original images remain as they are.

- This function can be used with all image types (p.3) supported by DPP. However, images with more than 6666 × 4444 pixels are not supported.
- The color space of a composited image will be the color space of the background image.
- Image information is not appended to a composited image.

1 Select a background image in the main window.

2 Select the [Tools] menu ➤ [Start Compositing tool].

The compositing tool window appears.

You can also select a background image from the edit window, edit image window, or [Collection] window.
3 Select the image to combine.

- Select the image to combine from the [Foreground Image] list box.

   - The selected image is displayed in the [Foreground Image] thumbnail display.
   - A preview of the combined background image and foreground image is displayed in the composite preview.

- The following images can be combined.
  - When a background image is selected in the main window ([Folder] window) or edit window: image in same folder as background image
  - When a background image is selected in the [Collection] window: image in the [Collection] window
  - When a background image is selected in the edit image window: image displayed in the thumbnail display area

- You can combine images of differing sizes.

4 Select a compositing method

- Select a compositing method from the [Composite Method] list box.

   - The compositing method selected in the composite preview is applied.
   - The compositing method can be selected from five types: Add, Average, Weighted, Lighten, and Darken. For details on each compositing method, see “Compositing Methods” (p.81).
   - If you select [Weighted], you can set the proportion of brightness of the image to be combined. Use the [Weight] slider at the bottom of the [Composite Method] list box or directly enter a value to set the brightness proportionally.
   - By clicking the [100% view] button, the image is displayed at 100% magnification (actual pixel size).
Position the images.

- By default, the background image and the [Foreground Image] are displayed with their centers aligned.
- [Compose in RAW Format]
  Checkmark the [Compose in RAW Format] checkbox as necessary.

  - You can set [Compose in RAW Format] under the following conditions. Both the background image and [Foreground Image] are RAW images, and, all the following conditions are met.
    - The cameras used to shoot were of the same model
    - The ISO speed setting at time of shooting was the same
    - The highlight tone priority setting at time of shooting was the same
    - The image sizes (original size) are the same

  - The following functions are not available for images composited with [Compose in RAW Format].
    - Auto Lighting Optimizer (p.61)
    - Picture Style Auto (automatically set to Standard) (p.59)
    - Selecting [Circle] for the aspect ratio when trimming (p.39)
Click the [Save As] button.

By clicking the [Save As] button, the [Convert and save] window (p.42) appears. Specify the required settings, and then click the [Save] button.

By clicking the [Continue] button, images are combined to create a new background image, and you can continue by combining another image.

To finish, click the [Close] button.

Compositing Methods

- **Add**
  The brightnesses of the background image and [Foreground Image] are added and images are overlaid.

- **Average**
  Images are overlaid with negative exposure compensation being applied automatically. If you want to change the amount of exposure for individual images, select [Weighted].

- **Weighted**
  Compositing method where brightness is set proportionally for the [Foreground Image].

- **Lighten**
  The background image and the [Foreground Image] are compared, with only brighter portions being combined.

- **Darken**
  The background image and the [Foreground Image] are compared, with only darker portions being combined.

Creating HDR (High Dynamic Range) Images

You can create images with a wide dynamic range where clipping in highlights and shadows has been reduced, and images that appear like paintings. This is suited for scenes such as still-lifes and landscapes. This function is most effective when using three images with different exposures of the same scene (negative exposure, standard exposure, positive exposure) to create an HDR image. However, you can also create an HDR image from two images, or even only one. Since an HDR image is saved as a separate image, the original images remain as they are.

* HDR stands for High Dynamic Range.

This function can be used with all image types (p.3) supported by DPP. However, images with more than 6666 × 4444 pixels are not supported.

Image information is not appended to an HDR image.
2 Select the [Tools] menu ➔ [Start HDR tool].

The [Select Images] window appears.

- You can also display the [Select Images] window from the edit window and edit image window.

3 Specify the required settings, then click the [Start HDR tool] button.

- To change the selected image, or add another image, click the [Browse] button and in the [Open] dialog box that appears, select the image file and click the [Open] button.
- If you select two images of the same size, you can checkmark the [Auto Align] checkbox for auto image alignment. However, auto image alignment may not work properly with repetitive patterns (lattice, stripes, etc.) or flat, single-tone images.

- By clicking the [Start HDR] button, the [Adjust Image] window appears.

⚠️ After using auto image alignment, the periphery of the images is partially deleted.
Make required selections to adjust the image.

**Sliders in [Adjust Image]**

- **[Tone/Color]**
  - **[Brightness]**: Adjusts the overall brightness of the image. Move the slider to the right to brighten the image, and to the left to darken the image.
  - **[Saturation]**: Adjusts the overall color saturation of the image. Move the slider to the right to make the color deeper, and to the left to make the color weaker.
  - **[Contrast]**: Adjusts the overall contrast of the image. Move the slider to the right to make contrast stronger and to the left to make contrast weaker.

- **[Detail Enhancement]**
  - **[Strength]**: Adjusts the overall contrast and contrast of details together. Move the slider to the right for a stronger effect.
  - **[Smoothness]**: Adjusts the overall smoothness of the image. Move the slider to the right for a smooth and natural impression.
  - **[Fineness]**: Adjusts the clearness of details. Move the slider to the right for a sharper outline.

- **[Presets] and finishing effects**
  With [Presets], you can select from the five preset finishing effects below from a pulldown menu ([Natural] is selected by default), instead of operating the sliders individually. By selecting a finishing effect, each slider moves according to the setting. You can also operate and adjust the sliders after selecting an effect.
  - **[Natural]**: In high-contrast scenes, rendering in areas where highlights or shadows are usually clipped is corrected, for a finish with reduced highlight and shadow clipping.
  - **[Art standard]**: Gives a finish with painting-like tonality for an impressive image.
  - **[Art vivid]**: For a more vivid look than with [Art standard].
  - **[Art bold]**: For a more vivid look than with [Art standard], that makes the subject pop out.
  - **[Art embossed]**: Tones down sharpness more than [Art standard], for an old-fashioned feel.
Click the [Save As] button.

By clicking the [Save As] button, the [Convert and save] (p.42) window appears. Specify the required settings and click the [Save] button.

Starting Up Map Utility

Map Utility is a software that allows you to view images shot on a GPS function-compatible Canon camera, including the shooting location and route travelled. After installing Map Utility to your computer, you can start it up from DPP.

Select the [Tools] menu ➔ [Start Map Utility].

Map Utility starts up.

For information about Map Utility, refer to the Map Utility instructions, or to the Help for Map Utility.

Do not edit images with DPP and use Map Utility at the same time. Editing results may not be saved properly.

Version 1.1.0 or later versions of Map Utility are compatible.

Map Utility is not included on the EOS DIGITAL Solution Disk.

[Start Map Utility] will not appear in the [Tools] menu if Map Utility is not installed to your computer.
Printing with Shooting Information
You can freely lay out one image on one sheet of paper and print together with titles and shooting information, etc.

1 Select one image to be printed.
2 Select the [File] menu ▶ [Print with detailed setting].
3 Specify the required settings for printing, and then click the [Print] button.

Switches the settings tab sheet

Print preview

- The image can be moved by dragging.
- Drag the four corners of the image to change the size.
- For the shooting information, click [ ] on the [Text] tab sheet and select the necessary items in the window that is displayed.

To maintain the settings
The settings of each tab sheet in step 3 are memorized when the [Apply] button is clicked (excluding the contents of the [Text] tab sheet). The settings can be applied to another image when printing.

- You can set printer profiles (p.93).
- If CMYK simulation has been set, the image is printed in the set colors (p.93).
Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

1. Select images to be printed in a thumbnail list.
2. Select the [File] menu ➔ [Contact Sheet Prints].
3. Specify the required settings for printing, and then click the [Print] button.

Switches the settings tab sheet

Print preview

To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply] button is clicked (excluding the contents of the [Text] tab sheet). The settings can be applied to another image when printing.

- You can set printer profiles (p.93).
- If CMYK simulation has been set, the image is printed in the set colors (p.93).
Printing RAW Images on a High-End Canon Printer

For high-end Canon inkjet printers that are compatible with the printing software Easy-PhotoPrint Pro, you can print with DPP by a simple operation that has the following features:

- Simple printing of RAW images
- Printing in faithful colors
- High quality printing using a wide color space of Adobe RGB, etc. and the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on your computer.

1. **Select the [File] menu ➔ [Plug-in printing] ➔ [Print with Easy-PhotoPrint Pro].**
   
   Easy-PhotoPrint Pro starts up.

2. **Match on-screen image colors and printing result colors.**
   
   - Select [Custom] in [Print Quality], click the [Set] button, and in the window that appears, drag the slider to [1] at the right end, and then click the [OK] button to close the window.
   
   Next, click the [Color Adjustment] button to display the [Color Adjustment] window and display the [Color Management] tab sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer Profile] to [Auto], and then click the [OK] button to close the [Color Adjustment] window.

3. **Specify any other required settings for printing, and then print.**

**Additional information**

- **Print up to 1000 images at a time**
  You can print up to 1000 images selected in DPP at a time. When printing more than 1000 images, divide the printing into several jobs.

- **Function set in DPP that is not applied to printing**
  Specified CMYK simulation (p.93) is not applied.

- **The printed image’s color is not what you expected**
  In the Easy-PhotoPrint Pro window, click the [Color Adjustment] button to display the [Color Management] tab sheet, set [Rendering Intent] to [Perceptual] (p.144), and try printing.

**Advantages of printing with Easy-PhotoPrint Pro**

- **Printing with faithful colors**
  When a color space is set (p.77, p.93), it is automatically transmitted from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful colors.

- **Printing with a wide color reproduction**
  When the color space setting (p.77, p.93) is set to a color space wider than sRGB (such as Adobe RGB), the image is printed with a wider color gamut than an image that has an sRGB color space, with green and blue in particular being reproduced vividly.
Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format imagePROGRAF printer. To print with DPP, first install imagePROGRAF Print Plug-In for Digital Photo Professional on your computer.

   → The Plug-In starts up.

2. Specify the required settings for photograph printing, and then print.

Additional information

- A single image can be printed at a time
  You can print a single image selected in DPP at a time. When printing multiple images, perform printing for each image individually.

- Functions set in DPP that are not applied to printing
  Specified output resolution (p.89) and CMYK simulation (p.93) are not applied.

Advantages of printing with imagePROGRAF Print Plug-In

- Printing with faithful colors
  When a color space is set (p.77, p.93), it is automatically transmitted from DPP to the Plug-In, allowing you to print with faithful colors.

- Printing with a wide color reproduction
  When the color space setting (p.77, p.93) is set to a color space wider than sRGB (such as Adobe RGB), the color reproduction range of the imagePROGRAF printer is fully utilized and the image is printed with a wider color gamut than an image that has an sRGB color space, with green and blue in particular being reproduced vividly.
Specifying Preferences
You can change the various functions of DPP in the [Preferences] window. Check the contents of each window and set. Also, depending on the item, a detailed explanation may be available, so refer to each window.

1. Select the [Tools] menu ➔ [Preferences].
   → The [Preferences] window appears.

2. Select the tab sheet, specify the settings, and then click the [OK] button.

![Preferences window](image)

General Settings
You can specify the folder that opens when DPP is started up, image quality of displayed and saved RAW images, etc.
Viewing and saving RAW images

You can select from two types of image quality for displaying/saving RAW images: high image quality with false color reduction processing and noise reduction function (p.62) used, or high speed without false color processing and noise reduction function used.

[High quality]
- False color reduction processing is automatically applied, and the image can be displayed/saved as a false color reduced-high quality image. Furthermore, you can use the noise reduction function (p.62) to reduce the luminance noise and chrominance noise.
- Because the effects of the false color reduction processing and noise reduction function are difficult to see in the [50% view] or [Fit to window] display of the edit window and edit image window, use [100% view] or [200% view] to check.
- We recommend that you normally set [High quality] for a balance between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
- If you checkmark [View images at high speed (moiré reduction off)], when the image is displayed in the edit window or the edit image window, false color reduction processing is not applied. However, you can use the noise reduction function.
- As the setting is the same as [High quality] other than for image display, the image undergoes false color reduction processing when it is saved.

[High speed]
- Since false color reduction processing is not applied, the display speed of a RAW image in the edit window or the edit image window, and the time it takes to save a RAW image is shorter than with [High quality].
- You cannot use the noise reduction function (p.62).
- Depending on the image, it may be displayed/saved with false color or noise being noticeable.

For images shot with ISO speed range expansion set, the difference in image quality between [High quality] and [High speed] becomes remarkable. To check the image quality of images shot with ISO speed range expansion, make sure to set [High quality] and check the images in the edit window or edit image window.

JPEG image quality

[Remove block noise and mosquito noise]
- You can improve the quality of a JPEG image by reducing the noise particular to JPEG images. This setting is also effective when RAW images are converted to JPEG images and saved (p.42, p.99) and for JPEG images that have been saved with a different name.

The extent of the improvement in noise reduction

The higher the JPEG image’s compression rate, the more noise is reduced. When the compression rate is low, the effect of noise reduction is negligible.

Default value of output resolution

You can set the resolution for RAW images converted and saved as JPEG or TIFF images (p.42, p.99).
View Settings
You can specify settings relating to the display.

- **Sort order in main window**
  You can set the order of images which have been rearranged in the main window to be maintained or not maintained (p.21).
  If you checkmark the checkbox, the order of the rearranged images is maintained even if you exit DPP or select another folder in the folder area.
  If you remove the check mark, the order of the rearranged images is not maintained and reverts to the previous order when you exit DPP or select another folder in the folder area.

- **Highlight/shadow warning**
  Highlighted/shaded areas that exceed the set range can be displayed on the image as warning indicators (p.55).
Tool Palette
You can specify settings for the tool palette.

- **Default settings of RGB tool palette**
  You cannot apply changes to the settings until you re-open the folder.

- **Changes are not applied to the edited image**
  Even if the default setting is changed, the new default setting is not applied to edited (i.e., adjusted using the tool palette, trimmed, dust-erased) images. Change each one individually.

- **Modified Picture Style settings**
  You can select whether the [Color tone], [Color saturation], [Contrast], [Unsharp mask] and [Sharpness] settings will be changed or retained, when you change the Picture Style.

  - If you checkmark the checkbox, the [Color tone], [Color saturation], [Contrast] and [Sharpness] settings will be changed to match the camera’s preset settings, when you change the Picture Style.
  - If you remove the check mark, the [Color tone], [Color saturation], [Contrast] and [Sharpness] settings will be retained, even if you change the Picture Style.

- **Default noise reduction settings**
  You can set a default beforehand for the noise reduction level.

  **RAW Images**
  - When [Apply camera settings] is selected, you can pre-set a noise reduction level that suits the camera settings beforehand as the default.
  - When [Set as defaults] is selected, you can pre-set a preferred default setting for the noise reduction level beforehand.

  **JPEG/TIFF Images**
  - You can set a desired default noise reduction level beforehand.

  For images not having a recipe attached, the default set here for noise reduction level is applied. However, if you want to apply settings to images in the opened folder, you need to re-open the folder after making settings here. For images with a recipe attached, the noise level recorded in the recipe remains as it is and the default for noise reduction level set here is not applied.

- **Advantages of setting a noise reduction default**
  In instances where the same level of noise occurs in several images, such as images shot with high ISO speed, setting an appropriate default noise reduction setting enables you to apply a batch noise reduction default to all the images displayed in DPP (excluding images with a recipe attached). This eliminates the need to apply noise reduction to each individual image. And, since you always shoot with the same conditions, it is also useful when you want to set the same noise reduction level for all shot images.
Color Management

You can specify settings relating to color management, such as settings for work color space, conditions for color matching, etc.

- Default settings of Work color space

You can select from five types of color space (p.144) that is applied as a default setting in RAW images. Color space that has been set is applied as the color space when a RAW image is converted and saved (p.42, p.99) or printed (p.43, p.46, p.49, p.85 to p.88).
- If you have changed the setting, and you restart DPP, the new setting is applied as the default setting color space.
- You can check color space that has been set in an image in the main window (p.124, p.125), the edit window (p.127), and the edit image window (p.133).

- Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not applied to edited (i.e., adjusted using the tool palette, trimmed, dust-erased) images. Change each one individually.

You can set a color space that is different from the default settings for each image (p.77).

- Display setting (color setting of the monitor)

Where a profile (p.143) is attached to the monitor you are using, you can display an image in more faithful colors by setting the profile.
- If you select [Use the OS settings], the color profile set in Windows will also be applied in DPP.
  If you are using multiple monitors, only the profile of the primary monitor is applied to DPP.
- If you use a profile created using a third-party monitor color reader, images can be displayed in even more precise colors.

- Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader, images can be displayed in even more precise colors.
Setting of printing profile (color setting of the printer)
Where a profile (p.143) is attached to the printer you are using to print images, you can print an image and simulate the colors displayed on screen by setting the profile. The profile that has been set is applied to all printing (p.49, p.85, p.86) except for printing using a Canon inkjet printer (p.43, p.46) or linked printing (p.87, p.88).

The adjustment function of the printer driver should not be used
Even if you set a printer profile, if you use the color adjustment function of the printer driver, the image may print in colors different from those displayed on screen.

Automatic settings for printing using EPP EX, EPP, and linked printing
If you are printing using a Canon inkjet printer (p.43, p.46) or using linked printing (p.87, p.88), a profile is set automatically even when the [Printing profile] setting is not performed. This allows you to print faithful colors easily.

Setting of CMYK simulation profile
You can select the color when printing in the CMYK environment of a printing machine, etc. from four types of profiles (p.144) and perform simulation on screen.
- When CMYK simulation has been set, [CMYK] appears (p.124, p.125, p.127, p.133) in the bottom of the main window, edit window and edit image window, and colors can be checked.
- To temporarily cancel CMYK simulation, press the <Ctrl> + <Y> keys.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.144) for printing using Easy-PhotoPrint (p.46).
- The rendering intent is ordinarily set to [Relative Colorimetric].
- When colors with [Relative Colorimetric] are not satisfactory, set to [Perceptual].
4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient function of batch processing large amounts of RAW images is explained here.

Utilizing Adjustment Contents (Recipe) .................... 96
  Saving Recipes as a File ............................................... 97
  Loading and Pasting Recipes ................................. 97
  Copying a Recipe and Applying to Another Image .... 97
Batch Apply White Balance to Images (Personal White Balance) ......................................................... 98
  Registering Personal White Balance ...................... 98
  Applying Personal White Balance ............................. 98
Batch Save as JPEG or TIFF Images (Batch Processing) ........................................................................ 99
Batch Transfer Images to Image Editing Software.. 100
Batch Change the File Name of Images ............... 101
  Changing the File Name of Images in the Order in the Main Window ........................................ 101
Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be saved as an individual recipe file (extension “.vrd”) and loaded and applied to another image. You can edit images efficiently by selecting and adjusting one image from images shot with the same shooting environment and batch applying the adjustment results to a large number of images.

The adjustment contents of JPEG or TIFF images (p.103) can be saved as a recipe file (extension “.vrd”) and loaded and applied to another image in the same way as with RAW images.

Additional information

Recipe data includes tool palette contents
Recipe data includes adjustments made with the tool palette ([RAW], [RGB], [NR/ALO] and [LENS]). For this reason, other editing content such as trimming or dust-erasure (copy stamp) is not included in the recipe data.

Recipes adjusted with the [RAW] tool palette can only be applied to RAW images
Adjustments in the [RAW] tool palette, which can only be made for RAW images, are not applied to a JPEG or TIFF image even if they are pasted.

Recipe data includes tool palette contents
Recipe data includes adjustments made with the tool palette ([RAW], [RGB], [NR/ALO] and [LENS]). For this reason, other editing content such as trimming or dust-erasure (copy stamp) is not included in the recipe data.

Recipes adjusted with the [RAW] tool palette can only be applied to RAW images
Adjustments in the [RAW] tool palette, which can only be made for RAW images, are not applied to a JPEG or TIFF image even if they are pasted.
Saving Recipes as a File

1. Select an edited image, and then select the [Edit] menu ➤ [Save recipe in file].
   ➔ The [Save recipe in file] dialog box appears.

2. Select the destination folder, enter a file name, and then click the [Save] button.

Check the contents of a recipe file by pasting to an image

When you do not know the contents of a recipe file, paste it to an image and check the settings in the tool palette. When only a few settings are adjusted, we recommend you use a file name that describes the contents or that you separately record the adjustments as text information.

Loading and Pasting Recipes

1. Select the image to which a recipe is to be applied, and then select the [Edit] menu ➤ [Read and paste recipe from file].
   ➔ The [Open] dialog box appears.

2. Select a recipe and click the [Open] button.
   ➔ The recipe is applied to the image.

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another image.

1. Select the image from which a recipe is to be copied and then select the [Edit] menu ➤ [Copy recipe to clipboard].
   ➔ The recipe is copied.

2. Select the image to which the recipe is to be applied and then select the [Edit] menu ➤ [Paste recipe to selected image].
   ➔ The recipe is applied to the image.
Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific shooting environment can be registered as personal white balance. You can then perform efficient white balance adjustment by applying this personal white balance to a large number of RAW images shot in the same shooting environment.

Registering Personal White Balance

1. Adjust the white balance (p.27, p.28, p.56).
   - To adjust white balance, select a setting other than [Shot settings] from the [White balance adjustment] list box (p.27). You will be unable to register the adjustments if you select [Shot settings].

2. In the [RAW] tool palette, click the [Register] button.
   - The [Register personal white balance] dialog box appears.

3. Select the button number to be registered from the list and click the [OK] button.

Applying Personal White Balance

1. In the main window, select the image to which white balance is to be applied.

2. Click the [Tool Palette] button on the toolbar.
   - The tool palette appears.

3. Click the personal white balance number button that is to be applied.

   Personal white balance is applied to all the selected images.

To use the registered personal white balance on another computer

1. In step 3, click the [Export] button to write as a file.
2. Copy the file to another computer.
3. In DPP on the other computer, display the window of step 3.
4. Click the [Import] button and in the window that appears, select the copied file.

You cannot change or adjust white balance with multiple-exposure RAW images created on the camera.
Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile JPEG or TIFF images.
The images are saved as separate images, so the RAW images remain unaffected.

1. In the main window, select multiple images to be converted.
2. Click the [Batch process] button on the toolbar (p.124).
   - The [Batch settings] window appears.
3. Specify the required settings, and then click the [Execute] button.
   - The batch processing dialog box appears and saving begins.
   - When all the images are saved, the [Exit] button appears in the batch processing dialog box.
4. In the processing dialog box, click the [Exit] button.

- The batch processing dialog box appears and saving begins.
- When all the images are saved, the [Exit] button appears in the batch processing dialog box.

**Saving images with recipe is not possible**

In the [Batch settings] window, you cannot perform [Save] or [Save As] (p.41, p.119) to edited RAW images.

💡 To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually being improved upon so that you can perform the latest image processing more appropriately.

Meaning that, between two differing versions of DPP, processing results may differ very slightly even if with the same RAW image data, or the results of significant editing of RAW image data with an attached recipe may be different.

When you want to save the developing or editing results of the version you are currently using as it is, it is recommended that you convert and save images as JPEG image or TIFF images.

💡 Skillful batch saving

- While saving is being performed, you can continue working in another window
  Since the saving function operates independently in the background, you can continue with an operation in another window such as the main window or the edit window during the saving process.
- To convert all images and save, do not select an image in the main window
  If you do not perform step 1 and perform step 2 with no image selected in the main window, all the images displayed in the main window will be converted and saved.

⚠️ If the message [Insufficient memory.] appears, too many images are selected at the same time. Decrease the number of selected images.

- If you have selected [New file name] in [File name], [Sequence number] has to be set.
- By saving as explained on this page, a trimmed image (p.38, p.111) or dust-erased image (p.73 to p.77, p.114 to p.118) actually becomes a trimmed image or dust-erased image.
- For a list of [Batch settings] window functions, see p.141.
Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike [Transferring a RAW Image to Photoshop] (p.77), you transfer images that have first been converted and saved as a separate image, so the transferred image will not disappear after exiting the destination software. The software used here as an example is Adobe Photoshop CS.

1. In the main window, select multiple images to be transferred.
2. Click the [Batch process] button on the toolbar (p.124).
   → The [Batch settings] window appears.
3. Perform settings required for transferring (e.g. file format).
4. Click the [Browse] button.
   → The [Open] dialog box appears.
5. Select Photoshop CS.
   → In the [Open] dialog box, select a Photoshop CS file or a shortcut and click the [Open] button.
   → The [Open] dialog box closes and [Image transfer settings] in the [Batch settings] window is set to Photoshop CS.
6. Checkmark [Open image using software].
7. Click the [Execute] button.
   → The processing dialog box appears and batch transfer begins.
   → When the first image has been transferred, Photoshop CS starts up and transferred images are displayed in transferred order.

⚠️ If the message [Insufficient memory.] appears, too many images are selected at the same time. Decrease the number of selected images.
Batch Change the File Name of Images

1. In the main window, select multiple images of which the file names are to be changed.
2. Select the [Tools] menu ▶ [Start Rename tool].
3. Specify the required settings (p.142) and click the [Execute] button.

→ Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text has appeared in [Modified File Name], the file name has been duplicated. Changes cannot be made if even one file name has been duplicated. Change the settings so that duplication does not occur.

⚠ The name of the movie files cannot be changed in DPP.

○ You cannot start up the rename tool from the [Collection] window (p.36, p.125).
○ For a list of the rename window functions, see p.142.

Changing the File Name of Images in the Order in the Main Window

When you change the order of the images in the main window, you can change in one operation the names of the files for the images, in the order they were rearranged.

1. Change the order of the images in the main window (p.21).
2. In the main window, select multiple images of which the file names are to be changed.
3. Select the [Tools] menu ▶ [Start Rename tool].
4. Select [Fit to main window].
5. Specify the required settings (p.142).
6. Click the [Execute] button.

→ The file names are changed and the order in the main window is maintained.

If the message [Insufficient memory.] appears, too many images are selected at the same time. Decrease the number of selected images.
DPP is software mainly aimed for advanced RAW image editing, but it also has JPEG and TIFF image editing functions. Here, the editing and saving of JPEG and TIFF images are explained.

Editing JPEG and TIFF Images
- About the RGB Tool Palette
- Automatically Adjusting Brightness and Color (Tone Curve Assist)
- Adjusting Brightness and Contrast
- Adjusting Color Tone Using Click White Balance
- Adjusting Hue, Saturation and Sharpness
- Tone Curve Adjustment
- Adjusting Dynamic Range
- Reducing Noise
- Trimming and Adjusting the Angle of an Image
- Performing Automatic Dust Erasure Processing
- Compatible Cameras
- Automatic Dust Erasure Processing in the Main Window
- Manually Erasing Dust (Repair Function)
- Erasing Unwanted Parts of an Image (Copy Stamp Function)
- Compositing and High Dynamic Range
- Starting Up Map Utility
- Saving Editing Results
- Saving Editing Content to an Image
- Saving as a Separate Image
- Applying Editing Contents to Another Image
- Printing
- Re-Editing an Image
Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as RAW images using the [RGB] and [NR/ALO] tool palettes. Because adjustment made with the tool palette (recipe) only changes the image processing conditions, the “original image data itself” remains unaffected. Therefore, there are no problems with image deterioration that arise with editing and you can readjust your images any number of times.

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and TIFF images with the same functions as ordinary image editing software. However, because the adjustment width of the adjustment functions in the [RGB] tool palette is wider than the [RAW] tool palette, the image color may be saturated, or the image quality may deteriorate if you adjust too much. Therefore, take care not to adjust your images to an excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette. However, for functions other than tone curve adjustment (p.108) and automatic adjustment (p.104), we recommend adjusting RAW images using the same functions available in the [RAW] tool palette.

In DPP all the adjustments (image processing conditions information) made with the tool palette can be saved in the image as data called a “recipe” (p.119), or can be saved, downloaded and applied to other images as a separate recipe file (extension “.vrd”) (p.96, p.119).
**Automatically Adjusting Brightness and Color (Tone Curve Assist)**

In order to make the image a desirable standard image, automatically adjust the image tone curve (p.143). You can select the degree of automatic adjustment from “Standard” and “High”.

**Click the desired automatic adjustment button.**

- **Standard:** Standard automatic adjustment. Suitable for most images.
- **High:** Use when the effect achieved in standard automatic adjustment is not strong enough.

![Diagram of Tone Curve Assist]

→ The tone curve changes as adjusted.

**Images not suitable for automatic adjustment (tone curve assist)**

The result of automatic adjustment (tone curve assist) may not be as expected with the following images:

- Images which have been shot with the proper exposure
- Images where the brightness is unbalanced
- Images which are too dark
- Images which have extreme backlighting

⚠️ If you click the button, the tone curve as well as the [Hue] and [Saturation] revert to the default settings. Take care when adjusting the [Hue] and [Saturation] individually (p.107).
**Adjusting Brightness and Contrast**

The brightness and contrast of an image can be adjusted.

- **Brightness**: Move the slider to the right to make an image brighter and to the left to make an image darker.
- **Contrast**: Used to adjust modulation and degree of contrast of color. Move the slider to the right to make contrast of an image stronger and to the left to make contrast weaker.

The adjustment range is –100 to +100 (in 1-stop increments when entering a value).
Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the standard for white to make the image appear natural. Using click white balance is effective when using it in parts of an image where white color tone has changed under the influence of a light source.

1. Click the [ ] button.

2. Click on a point that is to be the standard for white.

   - The coordinates of the cursor position and the RGB values (8-bit conversion)
   - The color of the image is adjusted with the point you selected as the standard for white.
   - If you click on another point in the image, the white balance is adjusted again.
   - To finish click white balance, right-click with the mouse or click the [ ] button again.

   ![Diagram of adjusting color tone using click white balance]

- When there are no white areas in your image

  When there are no white areas in your image, you can adjust the white balance by clicking on a grey point of the image in step 2. This has the same adjustment result as selecting a white point.

  - The image is adjusted based on the average value of 5 × 5 pixel range from the clicked point.
  - The histogram display changes according to adjustment. You can also fix the histogram display to the display before any adjustments (p.92).
**Adjusting Hue, Saturation and Sharpness**

You can adjust hue (tone) and saturation and make the overall atmosphere of an image harder or softer.

- **Hue:** Move the slider to the right to make color tones more yellow, and to the left to make color tones redder.
- **Saturation:** Move the slider to the right to make the color deeper, and to the left to make the color weaker.
- **Sharpness:** Move the slider to the right to make an image harder, and to the left to make an image softer.

![Adjusting Hue, Saturation and Sharpness](image)

**Drag the sliders left or right**

Enter numerical values

**Sharpness is unnatural**

Adjust sharpness with the window view set to [100% view], [50% view] or [200% view]. If the view is set to [Fit to window] (full view), the sharpness will seem unnatural.

The adjustment range is –30 to 30 for hue, 0 to 200 for saturation, and 0 to 500 for sharpness (in 1-stop increments when entering a value).
Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by changing the tone curve (p.143).

1 Select the tone curve mode and interpolation method.

Right-click with the mouse inside the graph to display the menu.

2 Make adjustments.

- Adjusts each channel
- Batch adjusts RGB
- Click to add a point (point)
- Adjust by dragging

The horizontal axis shows the input level and the vertical axis shows the output level.
- The maximum number of [ ] is 8.
- To delete a [ ], either press the <Del> key or double-click on the [ ].

The histogram display changes according to adjustment. You can also fix the histogram display to the display before any adjustments (p.92).
- The tone curve mode and interpolation method for a tone curve can also be changed in [Preferences] (p.92).
Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright points in an image can be adjusted.

- The setting range of shadow points is 0 to 247 (in 1-stop increments when entering a value).
- The setting range of highlight points is 8 to 255 (in 1-stop increments when entering a value).
- The histogram display changes according to adjustment. You can also fix the histogram display to the display before any adjustments (p.92).

The horizontal axis shows the input level and the vertical axis shows the output level.
Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have been shot at night or with a high ISO speed.

1. Select the [NR/ALO] tab sheet from the tool palette in the edit window or edit image window.

2. Click the [NR Preview] button.

3. Adjust an image.

   - You can set a noise reduction level from within a range of 0 to 20. The larger the setting, the larger the noise reduction effect.
   - The noise reduction effect can be checked when an image is displayed at 100% in the NR check window.
   - You can change the display position of the NR check window by dragging the enlargement display position in the navigator window.

4. Click the [Apply] button.
   - Noise reduction is applied to the image and the image is redisplayed.

   **To set the same noise reduction level for several images**

   After selecting multiple images in the main window, you can set the same noise reduction level for the images without displaying the [NR Preview] window, by adjusting the noise reduction level in the [NR/ALO] tool palette (p.129) using the [Luminance noise reduction] and [Chrominance noise reduction] sliders, and then clicking the [Apply] button.

   - If [Luminance noise reduction] has been set, resolution may be reduced along with reduction of noise.
   - If [Chrominance noise reduction] has been set, color bleeding may occur along with reduction of noise.
   - You can set the batch processing settings for noise reduction beforehand, using [Default noise reduction settings] in the [Tool palette] tab sheet in the [Preferences] (p.92). This is particularly useful for applying noise reduction to all the images in a folder at once, such as batch noise reduction for images with high ISO speeds. However, where images have a recipe attached, the noise level recorded in the recipe is applied.
   - For a list of [NR Preview] window functions, see p.131.
Trimming and Adjusting the Angle of an Image

You can trim only the part of an image you need, or change the composition of an image where an image shot horizontally becomes vertical. You can also adjust the angle of an image before trimming. If you select [Circle] for [Aspect ratio], the area outside the specified range will only be masked in black and the image will not be trimmed.

1. Select the image to be trimmed.

2. Open the trimming/angle adjustment window.
   - Click the [Trimming Angle] button.

   The trimming/angle adjustment window appears.
   - Editing can be done once the image is displayed clearly in the trimming/angle adjustment window.

3. Adjust the angle of the image as needed.

   - If you click [Center on Screen], you can display the trimming range in the center of the window.
   - If you click the [OK] button after adjusting only the angle of the image, the image will be trimmed at the largest possible trimming range.

When aspect ratio information is attached to an image shot with the EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS REBEL T3i/600D, the trimming range based on the aspect ratio information is displayed.
Select a ratio and drag the trimming range.

4 Select a ratio and drag the trimming range.

- The trimming range can be moved by dragging.
- You can enlarge or reduce the size of the trimming range by dragging the four corners of the trimming range. (Not available when [Circle] is selected.)
- List of aspect ratios (width : height)

<table>
<thead>
<tr>
<th>Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1</td>
</tr>
<tr>
<td>3:2</td>
</tr>
<tr>
<td>2:3</td>
</tr>
<tr>
<td>4:3</td>
</tr>
<tr>
<td>3:4</td>
</tr>
<tr>
<td>5:4</td>
</tr>
<tr>
<td>4:5</td>
</tr>
<tr>
<td>A Size Landscape</td>
</tr>
<tr>
<td>A Size Portrait</td>
</tr>
<tr>
<td>Letter Landscape</td>
</tr>
<tr>
<td>Letter Portrait</td>
</tr>
<tr>
<td>Custom</td>
</tr>
</tbody>
</table>

[FREE]: You can trim an image to any size, regardless of the selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in black. The image is not trimmed.

Click the [OK] button to return to the main window.

5 Click the [OK] button to return to the main window.

- The trimming range frame is displayed in the trimmed image (p.126).
- When the trimmed image is displayed in an edit window or the edit image window, it is displayed in its trimmed form.


**About trimmed images**

- **The trimmed range can be reverted to its original condition at any time**
  A trimmed image is displayed or printed as a trimmed image. However, since the image is not actually trimmed, you can always revert to the original image by clicking the [Reset] button in the trimming/angle adjustment window or performing the “Re-Editing an Image” procedure (p.120).

- **Display of the trimmed image in each window**
  - Main window: The frame showing the trimming range is displayed on the image (p.126).
  - Edit window: The image is displayed in its trimmed condition.
  - Edit image window: The thumbnail image is the same as the main window display, and the enlarged image is the same as the edit window display.

- **Printing a trimmed image**
  You can print as a trimmed image by printing it in DPP.

- **The image becomes a trimmed image when saved as a separate image**
  The trimmed JPEG or TIFF image actually becomes a trimmed image when saved as a separate image (p.119).

- **Images that have aspect ratio set will be displayed as trimmed images**
  When aspect ratio information is attached to a RAW image shot with EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS REBEL T3i/600D the set trimming range based on the aspect ratio information is displayed. Since the image is not actually trimmed, you can change the trimming range or revert to the condition before trimming. However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect ratio set with the EOS 5D Mark III, EOS 60D, EOS REBEL T4i/650D or EOS REBEL T3i/600D, its trimming range cannot be changed nor reverted to the condition before trimming, since the image is actually trimmed and saved in the set trimming ratio.

- **For images shot with ISO speed range expansion set, noticeable noise may make it difficult to view image details in the trimming/angle adjustment window, so using this function is not recommended.**

- **For a list of the trimming/angle adjustment window functions, see p.135.**
Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera that can attach this data, can be used to automatically erase dust spots.

**Compatible Cameras**

<table>
<thead>
<tr>
<th>Camera (Model)</th>
<th>Camera (Model)</th>
<th>Camera (Model)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EOS-1D X</td>
<td>EOS-1D Mark IV</td>
<td>EOS-1Ds Mark III</td>
</tr>
<tr>
<td>EOS-1D Mark III</td>
<td>EOS 5D Mark III</td>
<td>EOS 5D Mark II</td>
</tr>
<tr>
<td>EOS 7D</td>
<td>EOS 60D</td>
<td>EOS 50D</td>
</tr>
<tr>
<td>EOS 40D</td>
<td>EOS REBEL T4i/650D</td>
<td>EOS REBEL T3i/600D</td>
</tr>
<tr>
<td>EOS REBEL T2i/550D</td>
<td>EOS REBEL T1i/500D</td>
<td>EOS DIGITAL REBEL XSi/450D</td>
</tr>
<tr>
<td>EOS DIGITAL REBEL XTi/400D DIGITAL</td>
<td>EOS REBEL T3/1100D</td>
<td>EOS DIGITAL REBEL XS/1000D</td>
</tr>
</tbody>
</table>

1. In the main window, select an image appended with Dust Delete Data.
2. Click the [Stamp] button.

   → The copy stamp window appears.

3. When the image has redrawn itself, click the [Apply Dust Delete Data] button.

   → Dust spots are erased in a single operation.

4. Click the [OK] button to return to the main window.

   → The [ ] mark (p.126) is displayed on an image from which dust spots have been erased.

**Dust Delete Data** is not attached to images having settings specified during RAW processing on the camera for distortion correction, chromatic aberration correction, etc. As a result, you cannot perform automatic dust erasure processing on such images.
Additional Information

The dust-erased image can be reverted to its original condition at any time
A dust-erased image is displayed or printed as a dust-erased image. However, since the dust on the image is not actually erased, you can always revert to the original image by clicking the [Undo] button in the copy stamp window or performing the “Re-Editing an Image” procedure (p.120).

Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust erasure are displayed in other windows and you will be unable to check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the camera, if there is no dust to remove by DPP from the image, the [Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic dust erasure processing
In automatic dust erasure processing, dust spots are erased based on information relating to dust saved in the Dust Delete Data. However, there may be cases where you will not be able to erase dust spots depending on the type of dust. If this occurs, erase those dust spots using the repair function (p.116) or the copy stamp function (p.118).

The image becomes a dust-erased image when saved as a separate image
The dust-erased JPEG or TIFF image actually becomes a dust-erased image when saved as a separate image (p.119).

Useful functions of the copy stamp window

- Checking the dust erased spots
  After step 3, you can display and check in detail the erased dust spots one by one by pressing the <Shift> + <F> keys. (Press the <Shift> + <B> keys to return to the previous dust spot.)

- Canceling a specified erased dust spot only
  After step 3, you can press the <Shift> + <F> keys or the <Shift> + <B> keys to display the erased dust spot, and then press the <Shift> + <Del> keys to cancel only the erased dust spot displayed.

- Switch between full screen display/normal screen display using shortcut keys
  You can also switch between full screen display/normal screen display by pressing the <Alt> + <Enter> keys.

- Applying the dust erasure result to another image
  You can apply dust erasure to the same place in another image by clicking the [Copy] button to copy the dust erasure results and then displaying the other image to which you want to apply the results and clicking the [Paste] button.

For a list of the copy stamp window functions, see p.140.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete Data, and then select the [Adjustment] menu ➔ [Apply Dust Delete Data].

⇒ Dust spots in all the selected images are erased in a single operation.
Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

1. In the main window, select the image you want to erase dust spots.

2. Click the [Stamp] button.

   ➔ The copy stamp window appears.

3. When the image has redrawn itself, double-click the point from where dust is to be erased.

   ➔ The display changes to 100% view.
   ➔ The display position can be changed by dragging.

4. Click the button that matches the dust spots to be erased.
   - If the dust spot is dark in color, click the [ ] button, and if the dust spot is light in color, click the [ ] button.
   - When you move the cursor over the image, the dust erasure range appears as [ ].

5. Place the dust spot to be erased within the [ ] and click.

   ➔ The dust spot within the [ ] is erased.
   ➔ Click on another part of the image to continue erasing dust spots in the image.
   ➔ To erase dust in another part of the image, either right-click with the mouse, or click the button clicked in step 4 again to cancel dust erasure processing and perform the operation again from step 3.
   ➔ When the dust spot cannot be erased, [ ] is displayed.

6. Click the [OK] button to return to the main window.

   ➔ The [ ] mark (p.126) is displayed on an image from which dust spots have been erased.
Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing step 5 once, they may be erased completely when you click several times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be unable to erase lines of dust. In this case, use the copy stamp function (p.118).

The dust-erased image can be reverted to its original condition at any time
A dust-erased image is displayed or printed as a dust-erased image. However, since the dust on the image is not actually erased, you can always revert to the original image by clicking the [Undo] button in the copy stamp window or performing the “Re-Editing an Image” procedure (p.120).

Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust erasure are displayed in other windows and you will be unable to check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a separate image
The dust-erased JPEG or TIFF image actually becomes a dust-erased image when saved as a separate image (p.119).

Useful functions of the copy stamp window

Checking the dust erased spots
After step 5, you can display and check in detail the erased dust spots one by one by pressing the <Shift> + <F> keys. (Press the <Shift> + <B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only
After step 5, you can press the <Shift> + <F> keys or the <Shift> + <B> keys to display the erased dust spot, and then press the <Shift> + <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using shortcut keys
You can also switch between full screen display/normal screen display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image
You can apply dust erasure to the same place in another image by clicking the [Copy] button to copy the dust erasure results and then displaying the other image to which you want to apply the results and clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you can efficiently erase dust spots by clicking the images while holding down the <Ctrl> key in the main window, or, by selecting multiple images by clicking the first image and then clicking the last image while holding down the <Shift> key, and then displaying the copy stamp window.

For images shot with ISO speed range expansion set, noticeable noise may make it difficult to view dust spots in the copy stamp window, so using this function is not recommended.

For a list of the copy stamp window functions, see p.140.
Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part of the image to an unwanted part of the image.

1. **Follow steps 1 to 3 in “Manually Erasing Dust (Repair Function)” (p.116).**

2. **Specify the section to be copied.**
   - Click on the section that is to be the copy source while holding down the <Alt> key.
   - To change the section that is to be the copy source, perform the operation above again.
   - To fix the position of the copy source, checkmark [Fix Copy Source position].

3. **Correct the image.**
   - Click or drag on the section you want to correct on the image. [+ in the window indicates the copy source and [O] indicates the copy destination.
     - The copied image is pasted in the position to which it was dragged.
   - For [Pen type], you can select from [Brush] (the pasted image’s borders simulate a brush) and [Pencil] (the pasted image’s borders are sharp).

4. **Click the [OK] button to return to the main window.**
   - The [ ] mark (p.126) is displayed on a corrected image.

Compositing and High Dynamic Range

You can composite images also using JPEG and TIFF images in the same way as RAW images as described below.

- Compositing Images (p.78)
- Creating HDR (High Dynamic Range) Images (p.81)

Starting Up Map Utility

You can start up Map Utility using the procedure below.

- Starting Up Map Utility (p.84)
Saving Editing Results

Saving Editing Content to an Image
All the contents (recipe) adjusted with the tool palette (p.103 to p.110) as well as the trimmed range (p.111) and dust-erasure (p.114 to p.118) information can be saved to a JPEG or TIFF image, or to a separate JPEG or TIFF image.

Select the [File] menu  desired item.

- Your adjustments are saved to the image.

Saving as a Separate Image
If a JPEG or TIFF image is adjusted with the tool palette (p.103 to p.110) and then saved in the same way as a RAW image as described below, the image can be saved as a separate image with the adjustments (recipe) applied to it. Furthermore, if a trimmed image (p.111) or dust-erased image (p.114 to p.118) is also saved in the same way, it actually becomes a trimmed or dust-erased image.

- Saving as a JPEG or TIFF Image (p.42)
- Batch save as JPEG or TIFF images (batch processing) (p.99)

By saving as a separate JPEG or TIFF image as explained above, the adjustments made with the tool palette are applied, and some image deterioration that accompanies editing/saving occurs as when editing with ordinary image editing software.

Applying Editing Contents to Another Image
You can copy the adjustment contents (recipe) of JPEG and TIFF images that have been adjusted with the tool palette and apply them to another image with the procedures below, in the same way as with RAW images.

- Applying adjustment contents to another image (p.41)
- Utilizing adjustment contents (recipe) (p.96)

Printing
Edited JPEG and TIFF images can be printed with the procedures below as with RAW images.

- Printing (p.43)
- Printing with shooting information (p.85)
- Printing a thumbnail list (contact sheet printing) (p.86)
- Printing RAW images on a high-end Canon printer (p.87)
Re-Editing an Image

Only the image processing conditions are changed in images adjusted with the tool palette (p.103 to p.110), so the “original image data itself” remains unaffected. Also, the trimming range or dust-erase information of a trimmed image (p.111) or dust-erased image (p.114 to p.118) is simply saved to the image.

For this reason, you can undo any adjustments saved (p.119) to the image, trimming range and dust-erase information, and revert to the condition when last saved, or when the image was shot.

1 Select the image that is to be re-edited.

2 Select the [Adjustment] menu ➔ desired item.

→ The image reverts to the conditions of the selected item.
This reference section has been provided to enhance your experience using DPP.
It contains various troubleshooting solutions, how to delete DPP from your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find information you are looking for.

Troubleshooting.......................................................... 122
Deleting the Software (Uninstalling) ......................... 123
List of Main Window (Folder Window) Functions .. 124
List of Main Window (Collection Window) Functions... 125
Image Frame Information in the Main Window and Edit Image Window....................................................... 126
List of Edit Window Functions .................................. 127
List of Tool Palette Functions ................................... 128
List of NR Preview Window Functions ..................... 131
List of Quick Check Window Functions .................... 132
List of Edit Image Window Functions ....................... 133
List of Convert/Save One Image Window Functions .... 134
List of Trimming/Angle Adjustment Window Functions... 135
List of Lens Aberration Correction Window Functions... 136
List of Digital Lens Optimizer Adjustment Window Functions ............................................................... 137
List of Compositing Tool Window Functions .............. 138
List of HDR Window (Adjust Image) Functions ......... 139
List of Copy Stamp Window Functions ..................... 140
List of Convert/Save Multiple Images Window (Batch Processing) Functions ........................................... 141
List of Rename Window Functions ........................... 142
Glossary ................................................................ 143
Index...................................................................... 145
About This Instruction Manual................................. 149
Trademark Acknowledgments ............................... 149
Troubleshooting

If DPP is not operating correctly, refer to the items below.

Installation could not be completed correctly

- Select an administrator-level privilege ([Computer administrator], [Administrator], etc.) as a user setting. You cannot install the software if a user setting other than an administrator-level privilege is selected. For detailed information on selecting an administrator-level privilege, refer to your computer User's Manual.

DPP does not work

- DPP does not operate correctly on a computer if its system requirements are not met. Use DPP on a computer with compatible system requirements (p.3).
- Even if your computer has the RAM capacity (memory) described in the system requirements (p.3), if other applications are running at the same time as DPP, you may not have sufficient RAM (memory). Exit any applications other than DPP.

The card reader does not detect the SD card.

- Depending on the card reader and computer OS used, SDXC cards might not be correctly detected. In such a case, connect your camera and computer with the provided interface cable, and transfer the images to your computer using EOS Utility (provided software).

Images do not display properly

- Images that are not supported by DPP do not display. There are various types of JPEG and TIFF images, so JPEG images other than Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than Exif compatible images may not display properly (p.3).
- When a dust-erased image (p.73 to p.77, p.114 to p.118) is displayed in a window other than the copy stamp window, it is displayed as it was before dust erasure was performed. Check dust-erased images in the copy stamp window.

An image could not be adjusted

- The JPEG and TIFF images cannot be adjusted using the image adjustment function of the [RAW] tool palette. Adjust these images with the [RGB] tool palette (p.128).
- PowerShot Pro1 RAW images cannot be adjusted with the image adjustment function of the [RAW] tool palette. Adjust these images with the [RGB] tool palette (p.128).

A recipe could not be pasted (applied) to another image

- You cannot paste (apply) rotation (p.10, p.25, p.124, p.132, p.133), trimming (p.38, p.111), dust erasure (copy stamp) (p.73 to p.77, p.114 to p.118) of an image to another image as a recipe. Trim the image or erase dust of the image using the copy/paste function in each window and rotate each image individually.
- The adjustment contents (recipe) of RAW images that has been adjusted with the [RAW] tool palette cannot be applied to JPEG or TIFF images (p.128).
- The Auto Lighting Optimizer (p.61) is a function that is only available for RAW images shot with EOS-1D X, EOS-1D Mark IV, EOS 5D Mark III, EOS 5D Mark II, EOS 7D, EOS 60D, EOS 50D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D, EOS REBEL T1i/500D and EOS REBEL T3/1100D. You cannot apply the Auto Lighting Optimizer’s adjustment contents to RAW images shot with other cameras.

Color appears weak in the image when viewed with other software

- A RAW image which has a color space other than sRGB set (p.77, p.93) and is then converted and saved as a JPEG or TIFF image will appear weak in color when viewed in software that is only compatible with sRGB color space. In this case, set the RAW image color space to sRGB, convert again to a JPEG or TIFF image and save, and then view this image.
The colors of the image displayed on screen and the colors of the printed image do not match

- If the color of the monitor that displays an image is not adjusted correctly, or if a profile for a printer that is to print images, has not been set up, the color of the image displayed on screen and the color of the printed photograph may differ greatly. If the color of the monitor that displays images is corrected (p.93) and a profile for a printer is set up correctly (p.93), the color of a printed photograph and the color of an image on screen can be more closely matched. Using a Canon printer (p.43, p.46) or linked printing (p.87, p.88) automatically sets up printer profiles, so you only need to set the color of the monitor to bring the colors closer together.

- When printing using Easy-PhotoPrint and the Easy-PhotoPrint automatic compensation function and the various types of image adjustment functions are operating, colors are not printed correctly. Cancel all Easy-PhotoPrint image adjustment functions (p.47).

- Even if you set a printer profile, if you use the color adjustment function of the printer driver, the image may print in colors different from those displayed on screen. Do not use the color adjustment function of the printer driver.

Printing a large number of images in batches cannot be performed

- If a large number of images are printed in batches, printing may stop in the middle or the images may not be printed. Reduce the number of images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

- Delete [CRW_YYYY.THM] (camera index display image) if it remains in the folder from which images have been deleted (p.49).
  * Numbers are entered for [YYYY] in the file name.

The image information does not display

- A JPEG image set to Adobe RGB and shot with EOS 10D, EOS DIGITAL REBEL/300D DIGITAL and PowerShot Pro1 may not display image information (p.10, p.23).

Deleting the Software (Uninstalling)

- Exit any applications before uninstalling the software.
- Log in under an administrator-level privilege when uninstalling the software.
- To prevent computer malfunctions, always restart your computer after you have uninstalled the software. Re-installing the software without first restarting your computer is particularly likely to result in computer malfunctions.

1 Select the [ ] button ([Start] button in Windows XP) ➤ [All Programs] ➤ [Canon Utilities] ➤ [Digital Photo Professional] ➤ [Digital Photo Professional Uninstall].

2 Proceed with the uninstallation as directed by the on-screen messages.
  ➤ The software is uninstalled.
### List of Main Window (Folder Window) Functions (p.10)

<table>
<thead>
<tr>
<th>Function</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows/hides the tool palette *1</td>
<td>128</td>
</tr>
<tr>
<td>Shows/hides the folder area</td>
<td></td>
</tr>
<tr>
<td>Switches to the edit image window *2</td>
<td>133</td>
</tr>
<tr>
<td>Folder path</td>
<td></td>
</tr>
<tr>
<td>Toolbar *1</td>
<td></td>
</tr>
<tr>
<td>[Collection] tab sheet *5</td>
<td></td>
</tr>
<tr>
<td>[Folder] tab sheet *5</td>
<td></td>
</tr>
<tr>
<td>Check mark *2</td>
<td>19</td>
</tr>
<tr>
<td>Folder area *2</td>
<td></td>
</tr>
<tr>
<td>Image color space and work color space *3</td>
<td>77, 93</td>
</tr>
<tr>
<td>Image color space and work color space *3</td>
<td></td>
</tr>
<tr>
<td>Number of displayed images</td>
<td></td>
</tr>
<tr>
<td>Number of selected images</td>
<td></td>
</tr>
<tr>
<td>Rating *1</td>
<td>19</td>
</tr>
<tr>
<td>Image rotation (90 degree units)</td>
<td></td>
</tr>
<tr>
<td>Batch conversion/saving *2</td>
<td>99, 100, 141</td>
</tr>
<tr>
<td>Image rotation (90 degree units)</td>
<td></td>
</tr>
<tr>
<td>Recipe attachment status *4</td>
<td>96</td>
</tr>
<tr>
<td>CMYK simulation display *5</td>
<td>93</td>
</tr>
<tr>
<td>Displays the trimming/angle adjustment window</td>
<td></td>
</tr>
<tr>
<td>Displays the copy stamp window *3</td>
<td>140</td>
</tr>
<tr>
<td>Displays the quick check window *4</td>
<td>132</td>
</tr>
<tr>
<td>Cancels selection of all images *4</td>
<td>135</td>
</tr>
<tr>
<td>Selects all images</td>
<td></td>
</tr>
<tr>
<td>Shows/hides the folder area</td>
<td></td>
</tr>
<tr>
<td>Recipe attachment status *4</td>
<td></td>
</tr>
<tr>
<td>Number of displayed images</td>
<td></td>
</tr>
<tr>
<td>Number of selected images</td>
<td></td>
</tr>
<tr>
<td>Image information *2</td>
<td>23</td>
</tr>
</tbody>
</table>

*1 To switch between show/hide, select the [View] menu ▶ [Toolbar].
*2 The images inside the folders selected here are displayed in a thumbnail list on the right.
*3 Displays the coordinates of the cursor position and the RGB values (8-bit conversion) when click white balance was performed with the tool palette.
*4 The item selected in [Viewing and saving RAW images] (p.89) of the [Preferences] window is displayed.
*5 You can switch between the [Folder] and [Collection] windows.
List of Main Window (Collection Window) Functions (p.36)

- Toolbar
- [Collection] tab sheet*1
- [Folder] tab sheet

- Shows/hides the tool palette
- Switches to the edit image window
- Selects all images
- Cancels selection of all images
- Displays the quick check window
- Displays the copy stamp window
- Batch conversion/saving
- Displays the trimming/angle adjustment window
- Rating
- Image rotation (90 degree units)
- Check mark
- Image color space and work color space*2 (p.77, p.93)
- Display mode
- Recipe attachment status
- Number of selected images
- Number of displayed images
- CMYK simulation display

*1 The total number of images added to the [Collection] window is displayed in the ( ) in the [Collection] tab sheet. Accordingly, when an image is added that is displayed as a single image (p.22), twice the total number of displayed images is displayed.

*2 Displays the coordinates of the cursor position and the RGB values (8-bit conversion) when click white balance was performed with the tool palette.
Image Frame Information in the Main Window and Edit Image Window (p.10, p.34)

Information displayed when [Large thumbnail] (p.10) is selected

- **Check mark** (p.18, p.19)
- **Rating mark** (p.18, p.19)
- **Brightness adjustment value** (p.26)
- **White balance icon** (p.27)
- **File name**
- **Unsaved editing content mark**
- **GPS mark** (p.5)
- **Copy stamp mark** (p.73 to p.77, p.114 to p.118)
- **Lens aberration correction mark** (p.65)
- **Trimming range** (p.38, p.111)
- **Aperture** (p.3)
- **Shutter speed** (p.3)
- **File type** (p.2)
- **Image type** (p.2)
- **Digital Lens Optimizer mark** (p.69 to p.72)

*1 Does not display with [Small thumbnail].
*2 Displays in RAW+JPEG images displayed as a single image (p.22).
[RAW] is displayed in RAW images.
In [Small thumbnail] (p.10), [R] is displayed.
In PowerShot Pro1 RAW images, [RAW] is not displayed.

*3 Does not display with [Medium thumbnail] or [Small thumbnail].
*4 When aspect ratio information is attached to an image shot with EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS REBEL T3i/600D, the image is displayed as a trimmed image.
*5 Displayed on images shot on a GPS function-compatible Canon camera.
**List of Edit Window Functions (p.11, p.25)**

- **Path and file name of image**
- **Tool palette** *(p.128, p.129, p.130)*
  - Brightness adjustment
  - White balance adjustment
  - CMYK simulation display (p.93)
  - Picture Style
  - Image color space*3 and work color space (p.77, p.93)
  - Display mode*4

*1 To switch between show/hide, select the [View] menu ➔ [Tool palette].

*2 Displays the coordinates of the cursor position and the RGB values (8-bit conversion).

*3 RAW images are displayed with [RAW].

*4 The item selected in [Viewing and saving RAW images] (p.89) of the [Preferences] window is displayed.
List of Tool Palette Functions

**RAW Tool Palette** (p.25)
- Brightness adjustment (p.26)
- White balance adjustment (p.27, p.28, p.56)
- Picture Style settings (p.26, p.59)
- Dynamic range adjustment (p.57)
- Contrast adjustment (p.29)
- Shadow/highlight adjustment (p.57)
- Linear setting (p.29)
- Color tone and color saturation adjustment (p.29)
- Sharpness adjustment (p.31)
- Enlargement display position*

**RGB Tool Palette** (p.60)
- Automatic adjustment (tone curve assist) (p.33, p.104)
- Click white balance (p.106)
- Tone curve adjustment (p.58, p.108)
- Dynamic range adjustment (p.109)
- Brightness and contrast adjustment (p.105)
- Hue and Saturation adjustment (p.107)
- Sharpness adjustment (p.107)
- Enlargement display position*

* If an image is displayed enlarged, the enlargement display position can be moved by dragging. The enlargement display position appears when [Docking display] (p.92) has been set and the edit image window (p.133) has been enlarged.
NR/ALO Tool Palette
(When a RAW image is selected)

- Auto Lighting Optimizer (p.61)
- Apply noise reduction button (p.62)
- Displays the [NR Preview] window (p.62, p.131)
- Luminance noise reduction for RAW images (p.62)
- Chrominance noise reduction for RAW images (p.62)

NR/ALO Tool Palette
(When a JPEG or TIFF image is selected)

- Apply noise reduction button (p.110)
- Displays the [NR Preview] window (p.110, p.131)
- Luminance noise reduction for JPEG and TIFF images (p.110)
- Chrominance noise reduction for JPEG and TIFF images (p.110)

Enlargement display position*

If an image is displayed enlarged, the enlargement display position can be moved by dragging. The enlargement display position appears when [Docking display] (p.92) has been set and the edit image window (p.133) has been enlarged.
LENS Tool Palette

- Digital Lens Optimizer adjustment button (p.71)
- Amount of Digital Lens Optimizer (p.70)
- Lens data status (p.70)
- Lens data Update button (p.70)
- Lens aberration correction adjustment button (p.65)
- Lens aberration correction (p.65)
When you select a JPEG or TIFF image and display the [NR Preview] window, [TIFF/JPEG] appears and you can reduce luminance noise and chrominance noise for the JPEG and TIFF images.
List of Quick Check Window Functions (p.16, p.18)

Path and file name of image

50% view/100% view (moiré reduction off)/full view*1

Displays the image in full screen*2

Check mark display

Check marks (p.18)

Removes check marks (p.18)

Rating mark display

Rating (Reject) (p.18)

Rating (p.18)

Switches between displayed images

Displays the AF points (p.16)

Displays the image information window (p.24)

Image rotation (90 degree units)

*1 You can select 50% view/100% view (moiré reduction off) by selecting [Preferences] in the [Tools] menu and using [Quick check tool display] in the [View settings] tab sheet. You can also move the display position in the enlarged display by dragging the image.

*2 To return to the normal screen, press the <Esc> key.
List of Edit Image Window Functions (p.34, p.36)

- Shows/hides tool palette
- Shows/hides thumbnail display area
- Switches to main window (p.124)
- Image path and file name

Toolbar

- Thumbnail display area
- Information display
- Image color space and work color space (p.77, p.93)
- Display mode

- Images are displayed with [RAW].
- Displays the coordinates of the cursor position and the RGB values (8-bit conversion).
- Displays images selected in the main window. The image selected here is enlarged and displayed on the right.
- You can set the grid spacing with [Grid pitch] in the [Preferences] (p.91).
- The item selected in [Viewing and saving RAW images] (p.89) of the [Preferences] window is displayed.
List of Convert/Save One Image Window Functions (p.42)

<table>
<thead>
<tr>
<th>Types of image</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exif-JPEG</td>
<td>.JPG</td>
</tr>
<tr>
<td>Exif-TIFF 8bit</td>
<td>.TIF</td>
</tr>
<tr>
<td>TIFF 16bit</td>
<td>.TIF</td>
</tr>
<tr>
<td>Exif-Tiff 8bit+Exif-JPEG</td>
<td>.TIF/.JPG</td>
</tr>
<tr>
<td>TIFF 16bit+Exif-JPEG</td>
<td>.TIF/.JPG</td>
</tr>
</tbody>
</table>

**File name**

**Resolution**

The setting range is 1 to 60,000 dpi.

**Embeds of ICC profiles**

Color space (p.77, p.93) information that is set in an image is attached to an ICC profile. Even if you remove the check mark from images that have been set to Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77, p.93), the ICC profiles are embedded automatically.

**Size changing**

The larger of the two values set in [Width] and [Height] is applied to the longer edge of an image and change its size.

**JPEG compression rate**

The setting range is 1 to 10. The higher the numerical value, the higher the image quality becomes.

---

*1 The setting range is 1 to 60,000 dpi.
*2 Color space (p.77, p.93) information that is set in an image is attached to an ICC profile. Even if you remove the check mark from images that have been set to Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77, p.93), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the longer edge of an image and change its size.
List of Trimming/Angle Adjustment Window Functions (p.38, p.111)

- **Cancel**: Cancels all the trimming (aspect ratio) information.
- **Full screen display/returns to normal screen**
- **Reverts to the condition when the image was shot**
- **Ratio of trimming range** (you can also enter numerical values if you have selected [Custom])
- **Upper left coordinates of trimmed range** (you can also enter numerical values)
- **Size of trimmed range** (you can also enter numerical values)
- **Angle of image adjusted** (Drag bar, use the mouse to click ▲/▼ or enter numerical values to set angle)
- **Applies the copied trimming range to all other images**
- **Switches between displayed images**
- **Displays borders around a trimmed range**
- **Level of opacity outside a trimmed range**
- **Shows/hides grid lines** (Drag bar to set distance between grid lines)
- **Image rotation** (90-degree increments)
- **Displays the trimming range in the center of the window**

---

*1 If [Free] has been selected in the [Aspect ratio] list box, you can also drag the borders of the trimmed range to change its range.

*2 Operates when you have selected multiple images and the trimming/angle adjustment window is displayed.
List of Lens Aberration Correction Window Functions (p.65)

- When the list box for selecting an extender is displayed in the [Lens aberration correction] window, select the extender attached at the time of shooting from the list box.

- To correct distortion aberration of images shot with a fisheye lens, four effects can be selected from the [Effect] list box in addition to [Shot settings] normally used for distortion correction.

*1 The area you clicked on the image (Enlargement display position) is displayed at 200%.

*2 For RAW images shot with MP-E 65mm f/2.8 1-5x Macro Photo or EF 50mm f/2.5 Compact Macro with Life Size Converter EF, the slider indicator changes to the zoom magnification.
List of Digital Lens Optimizer Adjustment Window Functions (p.69)

- Enlargement display position (Navigator display)
- Shooting distance slider (p.72)
- Digital Lens Optimizer adjustment (p.72)
- Enlargement display section*1

*1 The area you clicked on the image being enlarged (Enlargement display position) is displayed at 100%.
List of Compositing Tool Window Functions (p.78)

- 100% display (p.79)
- Select foreground image (p.79)
- Thumbnail display for foreground image (p.79)
- Select composite method (p.79)
- Use RAW compositing (p.80)
- Weighting slider (p.79)
- Alignment controls (p.80)
- Continue compositing (p.81)
List of HDR Window (Adjust Image) Functions (p.81)

- Select an effect (p.83)
- Adjust tone/color (p.83)
- Adjust detail emphasis (p.83)
List of Copy Stamp Window Functions (p.73 to p.77, p.114 to p.118)

- Full screen display/returns to normal screen
- Applies Dust Delete Data (p.73, p.114)
- Types of dust to be erased (p.75, p.116)
- Specifies the copy source (p.77, p.118)
- Fixes the copy source position (p.77, p.118)
- Types of stamps (p.77, p.118)
- Sets the size of the dust erasure range (p.75, p.116) or copy range (p.77, p.118) in a range of 5 to 100 (in one pixel units) (you can also enter a numerical value)
- Restores/redoes the image
- Copies the dust erasure range or copy range and applies (pastes) it to another image
- Switches between displayed images*

* Operates when you have selected multiple images and the copy stamp window is displayed.
List of Convert/Save Multiple Images Window (Batch Processing) Functions (p.99)

1. File names of images to be batch saved
2. Embeds ICC profiles*2 (p.143)
3. Resolution*1
4. Size changing*4
5. Images to be converted are limited to RAW images*5

*1 The setting range is 1 to 60,000 dpi.
*2 Color space (p.77, p.93) information that is set in an image is attached to an ICC profile. Even if you remove the check mark from images that have been set to Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77, p.93), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher the image quality becomes.
*4 The larger of the two values set in [Width] and [Height] is applied to the longer edge of an image and change its size.
*5 Appears when you click the [Batch process] button (p.124, p.133) without an image selected in the main window or the edit image window. To convert RAW images only, instead of clicking the [Execute] button, click this button.
List of Rename Window Functions (p.101)

- **Sets the new file name**
- **Sets the format of information in the file name**

**Order in which images are sorted**
- Check mark to apply the same name to RAW images and JPEG images recorded simultaneously
- Check mark to copy the images
- Click the [Browse] button and set the save destination
Glossary

RAW image
EOS DIGITAL camera RAW images are recorded in an uncompressed 14bit or 12bit format. Because RAW images are special images in an undeveloped status, you need software with development processing functions such as DPP in order to view them. The advantage of the undeveloped RAW images is that you can make a variety of adjustments to RAW images with almost no deterioration of the image.
* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image
The most ordinary image in non-reversible compressed 8bit format. The advantage of this is that by saving at a high compression rate, the file size can be small, even for image data that has a high pixel count. Because during saving and compression part of the data is thinned out to make the file size small, every time you edit or save, the image deteriorates.
With DPP, even if you repeat editing/saving, only the recipe data is modified, and no overwriting or compression occurs so the original image data does not deteriorate.
* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image
Bitmap-format image recorded in a 8bit/16bit uncompressed format. Because TIFF images are in uncompressed format, they are suitable for saving an image while maintaining the original high image quality.
* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe
The “Image processing conditions information” for RAW images that can be edited in DPP is called a “recipe”. Further, in DPP, you can perform image editing on JPEG and TIFF images that use “recipes” as with RAW images.

bit number
Binary unit of information volume in the color of an image. The number shows the number of bits per pixel. The larger the number of bits, the more the color numbers and the gradation becomes smoother. A one-bit image is a black-and-white image.

Color Management System (Color Matching)
Digital cameras that shoot images, monitors that display images, and printers that print images each have a different way of creating color. For this reason, there may be a difference between the color of an image when viewed on a monitor and when printed.
A color management system is a system for managing color in order to bring these colors closer together. With DPP, you can more closely match color between different devices using ICC profiles between different devices.

ICC profiles
ICC profiles are files containing color information such as color characteristics and color space for various devices, set by the ICC (International Color Consortium). Most devices such as the monitor we use to view images or the printer we use to print images can be managed (color management) using these ICC profiles and the color between different devices can be more closely matched. DPP has color management that uses these ICC profiles.

Tone Curve
A tone curve shows values before adjustment (input) as the horizontal axis on a graph, and the values after adjustment (output) as the vertical axis. Since the values of before adjustment and after adjustment are the same before any adjustment is made, the tone curve displays as a straight line from bottom left to top right, and by changing this tone curve, you can adjust in detail the image’s brightness, contrast and color. The more you go right on the horizontal axis, the more the plus value it becomes, and the higher you go on the vertical axis, the more the plus value it becomes.
Color space
A color space is the reproducible color range (color gamut characteristics). DPP supports the following five kinds of color space.

- **sRGB**: Standard color space for Windows. Widely used for the standard color space of monitors, digital cameras, and scanners.
- **Adobe RGB**: A wider color space than sRGB. Mainly used for printing for business purposes.
- **Apple RGB**: Standard color space for Macintosh. A slightly wider color space than sRGB.
- **ColorMatch RGB**: A slightly wider color space than sRGB. Mainly used for printing for business purposes.
- **Wide Gamut RGB**: A wider color space than Adobe RGB.

Refer to the color chart below for the color area of each color space.

### Color chart of color spaces compatible with DPP

![Color chart of color spaces compatible with DPP](image)

<table>
<thead>
<tr>
<th>Color space</th>
<th>Gamma value</th>
<th>White point (color temp.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>sRGB</td>
<td>2.2</td>
<td>6500K(D65)</td>
</tr>
<tr>
<td>Adobe RGB</td>
<td>2.2</td>
<td>6500K(D65)</td>
</tr>
<tr>
<td>Apple RGB</td>
<td>1.8</td>
<td>6500K(D65)</td>
</tr>
<tr>
<td>ColorMatch RGB</td>
<td>1.8</td>
<td>5000K(D50)</td>
</tr>
<tr>
<td>Wide Gamut RGB</td>
<td>2.2</td>
<td>5000K(D50)</td>
</tr>
</tbody>
</table>

CMYK simulation profiles
A profile that simulates colors when printing in a CMYK environment (printing machine, etc.). With DPP, you can simulate color with four types of profile.

- **Euro Standard**: Profile normally used for book printing in Europe, suitable for simulation of standard European printing.
- **JMPA**: Profile normally used for book printing, etc. in Japan, suitable for simulation of magazine advertising standard color printing.
- **JapanColor2001 type3**: Profile becoming a standard in the Japanese printing industry, suitable for simulation of JapanColor standard printing.

Rendering intent
Rendering intents are color conversion methods when printing an image. The conversion method of each rendering intent is shown below.

- **Perceptual**: Before and after conversion, all colors are converted to maintain the relationship between colors. Even where colors slightly change, you can print a natural-looking image which has maintained color harmony. However, depending on the image, the saturation may change overall.

- **Relative Colorimetric**: There will not be much conversion to colors which are similar before and after conversion, but colors which are not similar are converted appropriately. Because there are little changes to similar colors which comprise most of an image, you can print a natural-looking image in which the saturation has not changed greatly. However, depending on the image, there are cases where the overall tone of an image changes somewhat as colors which are not similar and highlights change.
Index

A
Adjust JPEG Images ............................................................. 103
Adjust RAW Images ............................................................... 25
Adjust TIFF Images ............................................................... 103
Adjusting (JPEG or TIFF Image)
  Automatic Adjustment (Tone Curve Assist) ......................... 104
  Brightness ........................................................................ 105
  Click White Balance ......................................................... 106
  Contrast ............................................................................ 105
  Dynamic Range ................................................................. 109
  Hue .................................................................................. 107
  RGB Tool Palette ............................................................. 128
  Saturation .......................................................................... 107
  Sharpness ......................................................................... 107
  Tone Curve Adjustment ..................................................... 108
Adjusting (RAW image)
  Apply Adjustments ............................................................ 97
  Automatic Adjustment (Tone Curve Assist) ......................... 33
  Brightness ........................................................................ 26
  Brightness of Highlights .................................................... 57
  Brightness of Shadows ....................................................... 57
  Click White Balance ......................................................... 28
  Color Saturation ............................................................... 29
  Color Temperature ........................................................... 56
  Color Tone ........................................................................ 29
  Color Wheel ...................................................................... 56
  Contrast ............................................................................ 29
  Copy Adjustments ............................................................. 97
  Dynamic Range .................................................................. 57
  Filter Effect ........................................................................ 30
  Monochrome ...................................................................... 30
  Personal White Balance ..................................................... 98
  Picture Style ...................................................................... 26
  Picture Style File ............................................................... 59
  RAW Tool Palette ............................................................. 128
  Save Adjustments ............................................................. 97
  Tone Curve Adjustment ..................................................... 58
  Toning Effect .................................................................... 30
  Tool Palette ...................................................................... 128, 129
  White Balance .................................................................... 27
Adjustment Contents (Recipe) .................................................. 96, 143
Adobe RGB ........................................................................ 144
Apple RGB ........................................................................ 144
Arrange Images ................................................................... 20, 21
Auto Lighting Optimizer ....................................................... 61
Automatic Adjustment (Tone Curve Assist) ......................... 33, 104
Automatic Dust Erasure Processing ................................. 73, 74, 114, 115
B
Batch Apply White Balance to Images (Personal White Balance) ........................................... 98
Batch Change the File Name of Images ................................. 101
Batch Convert/Save Images (Batch Process) ......................... 99
Batch Process (Batch Save JPEG and TIFF Images) ............ 99, 141
Batch Process of Multiple Images
  Change File Name ............................................................. 101
  Convert/Save (Batch Process) ........................................... 99, 141
  Personal White Balance .................................................... 98
  Recipe Data ....................................................................... 96
  Transfer ............................................................................ 100
  Batch Settings Window ................................................... 99, 100, 141
  Batch Transfer Images .................................................... 100
  Batch Transfer Images to Image Editing Software ............... 100
  Before/After Comparison Display ........................................ 53
  bit Number ....................................................................... 143
  Bookmark ........................................................................ 51
  Brightness ........................................................................ 26, 105
C
Change File Name ................................................................. 101
Changing the File Name of Images in the Order in the Main
  Window ............................................................................. 101
Check Mark ........................................................................ 18, 19, 126, 132
Chromatic Aberration Correction ........................................ 65
Chrominance Noise Reduction (JPEG, TIFF Images) ............ 110
Chrominance Noise Reduction (RAW Images) ....................... 62
Click White Balance .......................................................... 28, 106
CMYK Simulation .............................................................. 93, 94, 144

Reference
Basic Operation
Advanced Operation
Advanced Image Editing and Printing
Editing JPEG/TIFF Images
Processing Large Numbers of Images
Introduction
Contents at a Glance
Index
Enlarged Display (Edit Window) ............................................... 11, 127
Enlarged Display (Quick Check Window) ................................. 132
EOS Utility .................................................................................. 7
Exiting DPP .................................................................................. 14
False Color Reduction ................................................................. 89, 90
Filter Effect .................................................................................. 30
Folder Window ............................................................................ 6, 124
General Settings (Preferences) .................................................... 89
Filter Effect ............................................................................... 30
Honing Effect .............................................................................. 30
Folder Window ............................................................................ 6, 124
Map Utility .................................................................................. 84
Monochrome ............................................................................... 30
Move or Copy Folders .................................................................. 51
Move or Copy Images .................................................................. 50
Noise Reduction (JPEG or TIFF Image) ........................................ 110
Noise Reduction (RAW Image) ..................................................... 62
NR Preview Window .................................................................... 62, 110, 131
NR/ALO Tool Palette .................................................................... 129
Create a Folder ............................................................................ 50
Delete Images ............................................................................. 49
Move or Copy Folders .................................................................. 51
Move or Copy Images .................................................................. 50
Register Folders as Bookmarks .................................................. 51
Peripheral Illumination Correction ............................................. 65
Personal White Balance ............................................................... 98
Picture Style .............................................................................. 26
Picture Style File .......................................................................... 59
Preferences .................................................................................. 89
Color Management ...................................................................... 93

Introduction ................................................................................ 29
Loading and Pasting (Applying) Recipes .................................... 97
Linear ......................................................................................... 29
Luminance Noise Reduction (RAW Images) ............................... 62
Luminance Noise Reduction (JPEG, TIFF Images) ..................... 110
Luminance Noise Reduction (RAW Images) ............................... 62
Main Window ............................................................................. 10, 124
Manual Dust Erasure (Repair Function) ...................................... 75, 116
Map Utility .................................................................................. 84
Monochrome ............................................................................... 30
Move or Copy Folders .................................................................. 51
Move or Copy Images .................................................................. 50
Noise Reduction of a JPEG Image (Luminance, Chrominance) .... 110
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62
NR Preview Window .................................................................... 62, 110, 131
NR/ALO Tool Palette .................................................................... 129
Create a Folder ............................................................................ 50
Delete Images ............................................................................. 49
Move or Copy Folders .................................................................. 51
Move or Copy Images .................................................................. 50
Register Folders as Bookmarks .................................................. 51
Peripheral Illumination Correction ............................................. 65
Personal White Balance ............................................................... 98
Picture Style .............................................................................. 26
Picture Style File .......................................................................... 59
Preferences .................................................................................. 89
Color Management ...................................................................... 93
Change the Display ................................................................. 10
Thumbnail Display and Enlarged Display (Edit Image Window) 34
Thumbnail Display of Images (Main Window) ......................... 10
  Change the Display ............................................................. 10
TIFF Image ........................................................................... 143
Tone Curve ........................................................................... 143
Tone Curve Adjustment ....................................................... 58, 108
Tone Curve Assist (Automatic Adjustment) ......................... 33, 104
Toning Effect ........................................................................ 30
Tool Palette
  LENS Tool Palette ............................................................. 130
  NR/ALO Tool Palette ......................................................... 129
  RAW Tool Palette ............................................................. 128
  RGB Tool Palette ............................................................. 128
Tool Palette (Preferences) ......................................................... 92
Transfer
  Batch Transfer Images to Image Editing Software ............... 100
  Transfer an Image to Photoshop ........................................ 77
  Transfer an Image to Photoshop ........................................ 77
Trimming and Adjusting the Angle of an Image ................. 38, 111
Trimming/Angle Adjustment Window .............................. 38, 111, 135
U
Unsharp Mask ........................................................................ 32
V
View Settings (Preferences) ................................................... 91
W
White Balance ....................................................................... 27
  Click White Balance .......................................................... 28, 106
  Color Temperature .............................................................. 56
  Color Wheel ....................................................................... 56
  Personal White Balance ....................................................... 98
Wide Gamut RGB ................................................................. 144
Work Color Space ................................................................. 77

About This Instruction Manual

- It is prohibited to reproduce, in whole or part, the contents of this Instruction Manual without permission.
- Canon may change without notice the software specifications and contents of this Instruction Manual.
- The software screens and displays printed in this Instruction Manual may differ slightly from the actual software.
- The content of this Instruction Manual has been reviewed thoroughly. However, if you should notice any errors or omissions, please contact a Canon Service Center.
- Please note that irrespective of the above-mentioned, Canon does not take responsibility for the outcome of the operation of the software.

Trademark Acknowledgments

- Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Adobe and Photoshop are registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
- Other names and products not mentioned above may be registered trademarks or trademarks of their respective companies.